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Maya FBX Plug-in What’s
New

The following section contains the new features and known limitations for this version of
the Autodesk Maya FBX Plug-in.

NOTE Consult the readme file for any last-minute changes to this release. Windows users
can find the readme, along with this Help system, in the Program Files > Autodesk FBX
folder. Macintosh users are offered the option to save the readme during the installation
process.

What’s new in this version
This section lists the new features included with this version of the Maya FBX
Plug-in. Click the hyperlinks below to see more details.

New features

This version of the Maya FBX plug-in includes the following new features:

■ MotionBuilder Front/Back Plate support on page 2

■ UI changes on page 2

■ Embedded Texture folder on page 2

■ Preserve Instances on page 3

■ New Troubleshooting section on page 3

■ Remove single keys on page 3

■ Embedded Textures on page 3
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■ New FBX format version on page 3

■ Animation layer support on page 4

■ Maya FBX References on page 4

■ Resample All option on page 4

■ MotionBuilder preset on page 4

■ Holes and Sharp corner support on page 4

■ Maya Pixel Aspect Ratio value support on page 4

MotionBuilder Front/Back Plate support
The Maya FBX Plug-in now imports both the MotionBuilder Front and Back
Plate planes into Maya, as well as exports Foreground and Background image
planes from Maya back into MotionBuilder. Previously, when you imported
a scene into Maya only one MotionBuilder plate would appear.

UI changes
The Maya FBX Plug-in is now shown within the Maya Import and Export
dialog boxes, instead of being in a stand-alone FBX Importer or Exporter
window. For more information see FBX Plug-in UI on page 25.

NOTE This UI change affects Maya 2011. Older versions of Maya (2010, 2009)
will still use the “classic” FBX Importer/Exporter window UI.

Embedded Texture folder
In previous versions of the Maya FBX Plug-in, when you imported an FBX file
with embedded media, the embedded files were extracted to a folder in the
same location as the FBX file.

If you did not have write permission to create that new folder, the media files
were not imported. This lack of write permission can occur when you work
over a network. Now, instead of not importing the media files, they are
extracted directly to a Temp folder.
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Preserve Instances
A new option in the FBX Exporter lets you export Maya Instances. See Preserve
Instances on page 47 for more information.

New Troubleshooting section
The Maya FBX Plug-in documentation contains a new Troubleshooting and
Limitations on page 119 chapter where you can locate the answers to some
common problems. In previous versions of the documentation, the Known
Limitations section appeared in the What’s New chapter. Now, these
limitations are documented in the Troubleshooting chapter.

Remove single keys
By default, the Maya FBX Plug-in exports all key animation even if it contains
only one key.

But a new option, Remove single keys, gives you the choice to ignore animation
that has only a single key on export to reduce file size. See Remove single key
on page 48.

Embedded Textures
You can now embed textures in ASCII files. This functionality does not exist
in FBX versions 2010 and earlier. See Embed media on page 56.

New FBX format version
A new FBX file format version has been created for this version of the Maya
FBX Plug-in. This new version of the FBX format contains file size
optimizations that result in a smaller exported file size. For example, a file
that once was 7 megabytes at export can export as small as 1 megabyte.

This size reduction gives you a quicker import speed due to the potential data
reduction.
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Animation layer support
This version of the Maya FBX Plug-in fully supports Maya and MotionBuilder
animation layers.

Maya FBX References
You can now use FBX files as References in Maya.

Resample All option
A new Resample All option lets you bake all supported and unsupported
elements. See Resample All on page 51.

MotionBuilder preset
Use the Autodesk MotionBuilder preset if you are using a Maya to
MotionBuilder back to Maya workflow. See Autodesk MotionBuilder preset
on page 42

Holes and Sharp corner support
This version of the Maya FBX Plug-in supports Smooth Mesh Preview Holes
and Sharp Corners.

Custom attributes and properties
The Maya FBX Plug-in supports custom properties (or extra attributes,) on
material nodes.

Maya Pixel Aspect Ratio value support
The FBX plug-in now supports the Maya Render Settings Pixel Aspect Ratio
value. The Pixel Aspect Ratio  value is automatically exported and imported
into Maya. This support assists with the import of cameras into Maya
Composite by maintaining camera fidelity.
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The aspect ratio represents the aspect ratio of the display device on which you
view the rendered image. The device aspect ratio represents the image aspect
ratio multiplied by the pixel aspect ratio.

This process occurs automatically; there are no settings to activate to obtain
this support.

Conversion support
The following sections are about how the Maya FBX Plug-in converts Maya
objects and their properties.

For a detailed report of conversion support for this version, see the Maya FBX
Compatibility Chart. The FBX compatibility chart explains what is supported
and at what level, when you export from Autodesk Maya and import into
Autodesk 3ds Max, Autodesk Mudbox or Autodesk MotionBuilder.

File textures, procedural, and map channels
The Maya FBX Plug-in supports texture files in almost any standard material
channel. Anything that you map in the Color, Bump mapping and other
channels translate to FBX, as long as they are not procedural maps.

SupportMap channel

SupportedColor

SupportedTransparency

SupportedAmbient color

SupportedIncandescence

SupportedBump

SupportedDiffuse

SupportedCosine power

SupportedSpecular color

SupportedReflectivity
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SupportMap channel

SupportedReflected color

The Maya FBX Plug-in supports file texture maps. If you are using either 2D
or 3D procedural textures, convert them to a file texture first.

NOTE The Maya FBX Plug-in ignores any maps applied to unsupported channels
on export.

Camera support
The following tables indicate how both Maya and the FBX file format treat
cameras.

Camera export
The following table lists Maya cameras and how the FBX file format treats
them on export:

Becomes in FBXIn Maya

Camera without interest.Camera

Camera with interest.Camera and Aim

Camera with interest and up vector.Camera, Aim, and Up

Field of View FCurve. The view is consistent
even though the focal length values

Angle of View

change when you import the FBX file into
3ds Max.

Near and Far clipping plane values are
supported but not animation.

Near/far clipping planes

CameraStereoStereo Camera

NOTE Any animation applied to a Maya camera’s Up node is baked onto the
camera’s rotation you import it into 3ds Max.
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Custom camera export

When the Maya FBX Plug-in exports Maya and 3ds Max custom cameras, the
exporter sets the Render resolution/PixelAspectRatio for all cameras. If no
custom cameras exist, the Render resolution/PixelAspectRatiovalues are not
exported.

NOTE Make sure your custom camera is the current camera in the scene when
exporting to FBX for the correct transport of the camera Render
resolution/PixelAspectRatio.

Camera import
The following lists how Maya treats MotionBuilder cameras on import:

Becomes in MayaIn FBX

CameraFree Camera

Camera and AimCamera (With a look-at Target/Interest)

Camera with an orthographic setting.Orthographic Camera

Custom camera import

When the Maya FBX Plug-in imports Maya and 3ds Max custom cameras, the
Render resolution/PixelAspectRatio applied to the scene is set by the current
camera. That is, the Render resolution/PixelAspectRatio from additional
cameras are ignored. If the current camera is not a custom camera, the Render
resolution/PixelAspectRatio values are not imported.

Light support
The following tables list Maya lights and how the plug-in treats them when
they are exported to the FBX file format and imported into Maya:

Light types

When imported back into MayaIn Maya

Point lightAmbient light

Directional lightDirectional light
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When imported back into MayaIn Maya

Spot lightSpot light

Point lightArea light

Point lightPoint light

Custom properties
Because of type limitations in FBX files, the following conversions are applied.

Becomes in FBXExported from Maya

VECTORVector

BOOLBoolean

INTEGERInteger

STRINGString

ENUMEnum

REALFloat

Becomes in MayaImported FBX

FloatREAL

BooleanBOOL

IntegerINTEGER

StringSTRING

VectorVECTOR

The Maya FBX Plug-in supports Extra Attributes (or custom properties) applied
to Materials and Transform nodes.
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Level of Detail group nodes
The Maya FBX Plug-in supports LOD (level of detail) group nodes. See the
Maya documentation on LOD group nodes for more information.

Joint Orients
The Maya FBX Plug-in converts Maya Joint Orients to pre-rotation on export.
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Installing the Maya FBX
Plug-in

Maya uses the Maya FBX Plug-in to import, export, and convert files using the FBX file format.
This chapter describes how to install the Maya FBX Plug-in on Windows®, Mac® OS X, and
Linux systems.

The Maya FBX Plug-in comes with Maya and is installed automatically. This procedure is
included so you can upgrade your Maya FBX Plug-in with later versions.

NOTE The Maya FBX Plug-in that accompanies your version of Maya may not be the
most recent version. It is a good practice to check for updates, as each subsequent Maya
FBX Plug-in version has enhanced functionality, and is available free. See Web updates
on page 35 for instructions on how to verify that your plug-in version is the latest.

IMPORTANT Plug-ins run only on the version of Maya for which they are created; verify
that the version of the Maya FBX Plug-in that you are installing is appropriate for the
version of Maya you are running.

The Maya FBX Plug-in is available for Windows®, Mac® OS X, and Linux systems.

Windows installation
The Maya FBX Plug-in is compatible with the following versions of Microsoft
Windows®:

■ Windows XP (32/64-bit)

■ Windows Vista (32/64-bit)

■ Windows 7 (32/64-bit)

2
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To install the Maya FBX Plug-in:

1 Exit Maya or deactivate fbxmaya.mll in Maya's Plug-in Manager before
installing.

NOTE If you install the Maya FBX Plug-in while the fbxmaya.mll driver is in
use, the installation cannot occur and an “Error opening file for writing”
message displays.

2 Download the install file from www.autodesk.com/fbx. See Downloading
the Maya FBX Plug-in on page 19 for information on downloading the
latest Maya FBX Plug-in.

3 Double-click the install file to launch the Autodesk Maya FBX Plug-in
installer.

4 Click I accept to accept the terms of the license agreement, and then click
Next.
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5 The next window shows the recommended installation location for the
plug-in. To specify another location, click Browse to launch the file
browser.

6 Click Next.

7 The next window shows the recommended installation location for the
plug-in documentation. To specify another location, click Browse to
launch the file browser.
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8 Click Install.

9 A series of dialog boxes appear asking if you would like to keep older
versions of the plug-in (if applicable), open the plug-in documentation
or view the read me file. Select Yes or No for each of these options.

NOTE The readme is located in the Program Files > Autodesk FBX folder,
along with this Help system.

10 The Installation completed window appears. Click Close to exit the
installer.

The Maya FBX Plug-in is now installed.
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Removing the Maya FBX Plug-in from Windows

To remove the Maya FBX Plug-in manually:

1 In Maya, disable the fbxmaya.mll Loaded and Autoload options in the
Plug-in Manager.

2 Exit Maya.

3 Delete fbxmaya.mll from the Maya<ver>\bin\plugins directory, where
<ver> is the version of Maya you have installed.

Macintosh installation
The Maya FBX Plug-in is available for Mac OS X 10.6.

To install the Maya FBX Plug-in:

1 Download the TGZ file from the Autodesk web site
(www.Autodesk.com/FBX) to your desktop.

2 Double-click the TGZ file to extract the Installation disk image.

3 Double-click the package icon to start the installation. The Welcome
pane appears.
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4 Click Continue to start the installation process. The Software License
Agreement pane appears.

5 Read the License Agreement and click Continue. A dialog box appears
asking if you accept the terms and continue with the installation.

6 Click Agree to accept. The Select a Destination pane appears. Select the
destination disk where you want to install the Maya FBX plug-in and
click Continue.

7 The Easy Install pane appears. Click Upgrade.

8 A dialog box appears asking you to enter your name and login password
to continue the installation.

NOTE You must obtain administrator privileges to continue installation.

9 The installation begins. A progress bar indicates the time remaining of
the installation. When the progress reaches 100%, the Finish Up pane
appears.
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10 Click Close to exit the installation program.

11 Start Maya and navigate to Window > Settings/Preferences > Plug-in
Manager.

NOTE

This installs the Maya FBX Plug-in to the following directory: <Macintosh
Drive>/Applications/Autodesk/maya<ver>/Maya.app/Contents/MacOS/plug-ins,
where <ver> is the version of Maya you have installed.

12 Activate the Loaded option for Fbxmaya.bundle in the Plug-in Manager.

13 Activate the Fbxmaya.bundle Autoload option so Maya loads the Maya
FBX Plug-in automatically at start-up.

NOTE The FBX readme file is available during the installation process. An
option to save the readme is offered at this time. This lets you save the readme
so that you can determine where to store it.
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Removing the Maya FBX Plug-in from Mac OS X

To remove the Maya FBX Plug-in:

1 In Maya, deactivate the fbxmaya.bundle Loaded and Autoload options in
the Plug-in Manager.

2 Exit Maya.

3 Locate the fbxmaya.bundle plug-in. This file resides in the <Macintosh
Drive>/Applications/Autodesk/maya<ver>/Maya.app/Contents/MacOS/plug-ins
directory, where <ver> is the version of Maya you have installed.

4 Delete the fbxmaya.bundle file.

Linux installation
The Maya FBX Plug-in is available for Linux.

Linux compatibility

The Maya FBX Plug-in is compatible with the following versions of the Linux
Operating system:

■ GCC 4.0.2 (32- and 64-bit)

To install the Maya FBX Plug-in:

1 Download the installation file from the Autodesk web site
(www.Autodesk.com/FBX).

2 Remove the old plug-in from the /usr/Autodesk/maya<ver>/bin/plug-ins/
(where <ver> is the version of Maya you have installed,) directory by
entering rm –f fbxmaya.so at the command prompt.

3 Type the following command to install the Maya FBX Plug-in:

./fbx<ver>_maya<ver>_linux_enu

(Where FBX<ver> is the version of the Maya FBX Plug-in you have installed).

This installs the plug-in to the following directory:

/usr/Autodesk/maya<ver>/bin/plug-ins/ (where <ver> is the version of Maya
you have installed).
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If you install Maya in another folder, you can specify the path on the
Command Line after: ./fbx<ver>_maya<ver>_linux_enu /home/maya/mypath/

(Where FBX<ver> is the version of the Maya FBX Plug-in you have installed.)

1 Start Maya and navigate to Window > Settings/Preferences > Plug-in
Manager.

2 Activate the Loaded option for Fbxmaya.so in the Plug-in Manager.

3 Activate the Fbxmaya.so Autoload option so Maya loads the Maya FBX
Plug-in automatically at start-up.

Removing the Maya FBX Plug-in from Linux

To remove the Maya FBX Plug-in:

1 In Maya, deactivate the fbxmaya.so Loaded and Autoload options in the
Plug-in Manager.

2 Exit Maya.

3 Log into your system as root.

4 Remove the Maya FBX Plug-in by entering the following command:

rm –f /usr/Autodesk/maya<ver>/bin/plug-ins/fbxmaya.so

Downloading the Maya FBX Plug-in
The Maya FBX Plug-in is available for free download.

The Maya FBX Plug-in that accompanies your version of Maya may not be
the most recent version. It is a good practice to check for updates, as each
subsequent Maya FBX Plug-in version has enhanced functionality, and is
available free. See Web updates on page 35 for instructions on how to verify
that your plug-in version is the latest.

To download the Maya FBX Plug-in:

1 Go to www.autodesk.com/fbx

2 Click the Download FBX Plug-ins and Tools link for the latest SDKs and
FBX plug-in releases.

3 Click the FBX Plug-ins, Converter, and QuickTime Viewer Downloads
link.
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4 Fill out the form that appears and click Submit. This takes you to a page
where the plug-ins reside.

NOTE The Maya FBX Plug-ins are categorized by type, operating system,
then application version.

5 Click the FBX plug-in link to download the corresponding FBX installer.

NOTE To find older versions of the Maya FBX Plug-ins, click the Plug-in and
Converter Archives link at the bottom of the web page.

Checking your version number
Once you complete the installation, run the Maya FBX Plug-in. When you
import and export, you can find the FBX version number in the Options >
File Type Specific Options > Information.

The Maya FBX Plug-in that accompanies your version of Maya may not be
the most recent version. It is a good practice to check for updates, as each
subsequent Maya FBX Plug-in version has enhanced functionality, and is
available free. See Web updates on page 35 for instructions on how to verify
that your plug-in version is the latest.
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If your version is not the latest, you can update it for free. See Downloading
the Maya FBX Plug-in on page 19.

Removing the plug-in
When you install the Maya FBX Plug-in, it installs two instances of the plug-in:
the actual FBX plug-in that is copied to the source directory (C:\Program
Files\Autodesk\Maya2011\bin\plug-ins) and a copy that is stored in the FBX
folder that you specified during the installation.
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The installation screen that specifies a destination folder

When you uninstall the Maya FBX Plug-in, the uninstall process only removes
the plug-in copy from the from the destination folder you specified during
the installation. To remove the FBX plug-in completely, you must delete it
manually. The reason you must perform a manual deletion is because the FBX
plug-in is a part of the default Maya installation.

Essentially, when you uninstall, you remove the contents of the FBX backup
folder, for example, C:\Program Files\Autodesk\FBX\FBXPlugins\2011.2\Maya
2011 64-bit, as well as any related entries in the Start menu.

It is good practice to keep the previous version of the plug-in, especially if you
are working on a project where the workflow is heavily dependent upon the
plug-in. If the newer version of the plug-in disrupts your process in some way,
you can revert to the previous version. If you do not want to lose access to
the FBX plug-in that ships with the Maya software, select Yes when asked if
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you want to accept saving copies of the old plug-in. This option occurs
whenever you install newer versions of the FBX plug-ins.

NOTE For addtional notes on uninstalling Macintosh and Linux versions of the
Maya FBX Plug-in, see Removing the Maya FBX Plug-in from Mac OS X on page
18 and Removing the Maya FBX Plug-in from Linux on page 19.
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FBX Plug-in UI

This section describes the Maya FBX Plug-in user interface which appears on the right side of
the Maya Import or Export dialog box under the General options when you select the Maya
Import and Export functions from the File menu.

The FBX options and menus are contained within rollout menus that you can expand and
collapse.

Maya Export All window A. FBX Exporter options

Switching the FBX UI
The Maya FBX Plug-in is available to you in two ways: the OS Native UI, which
shows the plug-in in a stand alone Importer or Exporter window, or the Maya

3
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Default, which shows the plug-in as options within the Maya Import or Export
dialog boxes.

Two versions of the FBX UI A. Maya Default B. OS native

Changing the UI

To switch between the OS Native “classic”-look UI and the Maya Default UI,
select Window > Settings/Preferences > Preferences. In the Preferences dialog
box, locate Files/Projects and scroll down to the File Dialog options.

You can also create your own presets. See Creating a custom preset on page
27.

Hiding the UI

You can hide the plug-in when it is in the Maya Default setting if you drag
the center splitter bar to the right. This collapses the FBX Plug-in options.
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Creating a custom preset
You can design your own preset where you design the UI with options and
settings specific to you needs. You can then share this preset with others.

To create a custom preset

1 Select File and click the option box next to Import, Export All, or Export
Selection.
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NOTE You cannot create custom FBX presets using the Export Edits and
Export Proxy Asset option boxes.

The Options dialog box appears.

2 Select FBX export from the General Options File type menu.
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File type menu

The Edit Preset button appears in the File Type Specific Options rollout.

3 Click the Edit Preset button to show the Export/Import Options dialog
box.
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Edit preset option

4 The UI of the  Edit Preset dialog box is split into two sections, adding a
tree view of the FBX options in the left section.

5 Select, and then right-click elements in the Tree View to access the Edit
options. See Edit mode options on page 33 for a guide to the available
preset design options.
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NOTE Some edit options are common to all structure levels, while some are
specific to a particular structure level. You can apply some options at any
level of the options structure. See Edit mode options on page 33.

6 Once you have finished, click Save preset.

7 The Saving new preset dialog box appears. Type the name of the new
preset for example, “MyNewPreset”.
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The new preset appears in the Maya FBX Plug-in the next time you load
Maya.

The Maya FBX Plug-in stores custom presets in a file so you can share them
with other users. You can find custom preset files in My
Documents\Maya\FbxPresets directory.

NOTE Bake Animation Start/End/Step values cannot be saved in presets. The Maya
FBX Plug-in always derives these values from the exported scene. For more see
Preset Bake Animation settings on page 125

Storing presets
You can save your custom presets in a file that you can share with other users.
Consult the table for the location of your saved presets.

Preset locationPlatform

C:/Users/<username>/Docu-
ments/maya/FBX/Presets/<current plug-in
version>

Windows

/Users/<username>/Library/Prefer-
ences/Autodesk/maya/FBX/Presets/<cur-
rent plug-in version>/import

Macintosh
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Preset locationPlatform

/home/<username>/maya/FBX/Pre-
sets//<current plug-in version>/import

Linux

NOTE The table above shows the path for the import presets. Export presets follow the
same path but use “export” instead.

Preset files have the file extension .fbximportpreset (for import) and
.fbxexportpreset (for export), for example, My Preset.fbximportpreset.

These presets are stored by user name so that multiple users can store custom
presets on the same machine.

You can also run the MELscript command to locate the FBX users preset path:

internalVar -userAppDir

Edit mode options
Use the Edit Mode options to customize your Maya FBX Plug-in UI preset.

Show/Hide

Use this option to activate or disable the visibility of a group or option in the
UI.

Enable/Disable

Use this option to lock the group or option so that it appears grayed-out in
the UI and cannot be modified.

Expand/Collapse

Use this option to change whether the group or option is expanded (A) or
collapsed (B) by default in the UI.
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View as expandable group/View as expanded Panel

Use this option to set whether a group is expandable (A) or not (B).

Help
Click the Help on FBX button in the Information rollout to access the Maya
FBX Plug-in documentation.
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Web updates
Click the Web Updates button in the Information rollout to make sure that
you are using the latest version of the Maya FBX Plug-in.

This function searches the Autodesk web site for a newer version of the plug-in
you are currently using.
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If you have the latest version, the following message appears:

If a newer version of the Maya FBX Plug-in is available, a window appears to
inform you.

36 | Chapter 3   FBX Plug-in UI



See Windows installation on page 11, Linux installation on page 18, and
Downloading the Maya FBX Plug-in on page 19 for information on
downloading and installing the latest Maya FBX Plug-in.

Export/Import or Cancel
At the bottom of the Maya Import or Export window, you can find
Export/Import and Cancel buttons.

Export/Import

Use the Export All, Export Selection, or Import button to start the export or
import process.

Cancel

The Cancel button closes the Export or Import window without performing
any action.
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Export

This section contains information about options you can use in the Maya FBX Plug-in Exporter
window.

Maya Export All dialog box A. FBX Export options

Exporting from Maya to an FBX file
To export your Maya scene:

1 Launch Maya.

2 Select File > Export All, or File > Export Selection. The Export All, or Export
Selection dialog box appears.

4

39



3 Select FBX from File of Type menu.

NOTE If you do not see the FBX file extension in the File of Type menu,
activate fbxmaya.mll in Maya's Plug-in Manager.

4 Enter a name for the FBX file you want to export.

5 The FBX Export options appear at the right of the Maya Export dialog
box.

6 Set the export options you want to use or select a preset from the Presets
menu. The Autodesk Media and Entertainment preset contains the best
balance of options for a general animation workflow. The Autodesk
MotionBuilder preset contains options set for character animation using
Maya and MotionBuilder.

See Selecting a preset on page 70 for more information about presets.
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7 Click Export in the Maya Export dialog box.

8 If conversions or errors occur during the export process, the Warning
Manager reports them at the end of the export process. See Show/Hide
Warning Manager on page 87 for information about the Warning
Manager.

NOTE There is a difference between “Errors” vs. “Warnings”. The plug-in
reports an error when something unexpected occurs. When the plug-in
reports an error, it indicates that the consequences of that error are unknown.
Warnings inform users when the plug-in applies conversions to the source
data to convert the data into a format that the destination application can
read.

File Type Specific options

Presets

The Maya FBX Plug-in has two export workflow presets:

■ Autodesk Media & Entertainment preset on page 42

■ Autodesk MotionBuilder preset on page 42

The Autodesk Media and Entertainmentpreset is the default preset for the
Maya FBX Plug-in Exporter. The Autodesk MotionBuilder  preset is used for
exporting animation files to MotionBuilder.

Selecting a preset

Choose your preset by selecting it in the menu of the Maya FBX Plug-in Presets
section.
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Editing presets

If you change a preset, the preset field displays User defined, to show that the
preset differs from its default state. The plug-in saves the User defined state
in a temporary file so that the settings are the default the next time you use
the plug-in.

You can also use save your settings as a custom preset. See Creating a custom
preset on page 27.

Autodesk Media & Entertainment preset
The Autodesk Media and Entertainment preset contains the optimal settings
for most animation workflows.

Autodesk MotionBuilder preset
Use the Autodesk MotionBuilder preset if you are using a Maya to
MotionBuilder back to Maya workflow. This preset uses the Constraints on
page 55 and FBIK definition on page 55 options set for optimal Character
animation using Maya and MotionBuilder.
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Include
The Include rollout lets you decide what data and conversions the plug-in
applies to your scene at export from a host application.

Geometry
Expand the Geometry rollout to access options related to exporting geometry
from your scene.

Smoothing Groups
When you activate this option the Maya FBX Plug-in converts edge information
to Smoothing Groups and exports them with the file.

When this option is disabled, no edge information is converted to Smoothing
Groups.
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Smoothing Groups and Collada

The FBX Collada exporter does not export Smoothing Groups data from 3ds
Max. Because of this, the FBX Collada importer will generate Smoothing
Groups during the import process.

If you disable the Smoothing Groups option, no Smoothing Groups are
generated by the FBX Collada importer.

Split per-vertex Normals
Activate this option to split geometry vertex normals based on edge continuity.
Vertex normals determine the visual smoothing between polygon faces. They
reflect how Maya renders the polygons in smooth shaded mode.

This option only applies to older MotionBuilder workflows to ensure visual
fidelity of surface continuity. It lets you transfer hard edge information to
MotionBuilder.

This workflow is required because of limitation in MotionBuilder versions
2010 and earlier where there is no support ByPolygonVertex Normals.

Why would I use this?

This option lets you keep the same hard/soft edge look that you get from Maya
in MotionBuilder.

Do not use this option if you do not require hard edges in MotionBuilder,
since this operation duplicates vertex information and converts the geometry
itself. You can use the Combine per-vertex Normals option in the FBX Importer
to perform the inverse operation, but this may result in incorrect UV texture
maps, see the note that follows this entry.

If you are not using a merge-back workflow (merging FBX into existing scene)
using this option may result in incorrect UV mapping when reimporting the
FBX file into Maya. Import your FBX file into to your original Maya scene, to
avoid geometry UV issues with split geometry.

Exporting with the Split per-vertex Normals option disabled produces the
following result in MotionBuilder 2010 and earlier:
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Split per-vertex Normals option disabled on export produces this result
in MotionBuilder 2010 and earlier

Exporting with the Split per-vertex Normals option activated produces the
following result in MotionBuilder:

Split per-vertex Normals option activated on export produces this result
in MotionBuilder 2010 and earlier

NOTE Using this option alters UV maps applied to geometry permanently. The
UVs are then properly reassigned to the newly split geometry. When you import
this geometry into an empty Maya scene, there is a UV limitation where using
Combine per-vertex Normals in the FBX Importer might result in incorrect UV
assignments.

Tangents and Binormals
Activate this option if you want the Maya FBX Plug-in to create tangents and
binormals data from UV and Normal information of meshes. This way you
have a tangent space representation of your meshes that you can use for
advanced rendering.
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NOTE Your geometry must have UV information or the Maya FBX Plug-in cannot
create tangents and binormals.

Why do I want to do this?

Exporting tangent and binormal data is useful when you define the local
coordinate system for each vertex in the mesh, which is referred to as “Tangent
space”. This is often required for advanced rendering techniques such as
normal mapping.

The Maya FBX Plug-in reads the UV data and uses it to calculate the Tangent
space data for normal perturbation in per-pixel lighting.

Smooth Mesh
The Smooth Mesh option lets you export source mesh with Smooth mesh
attributes. To export the source mesh, disable the Smooth mesh Preview
attribute in Maya, and then export.

If you activate the Smooth Mesh option, the mesh is not tessellated, and the
source is exported with Smooth Mesh data. If you disable the Smooth Mesh
option, the mesh is tessellated and exported without Smooth Mesh data.

NOTE If you export a Smooth Mesh Preview from Maya with the FBX Exporter
Smooth Mesh option disabled, it will not affect the mesh in the scene. Instead
your result is a tessellated mesh in the file, but with the original source mesh
unaffected/unchanged in the Maya scene.

Selection Sets
The Selection Sets option lets you include or exclude Selection Sets during the
export process.

Because including Selection Sets can potentially increase the file size, this
option is disabled by default, and the Selection Sets not are exported.

You must activate this option to export Selection Sets.

Convert to Null Objects
Activate this option to convert all geometry into locators (dummy objects)
during the export process.
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This option is often used for animation only files. It creates a smaller file size,
and is supported by FBX Importer when you import it into the original scene.

In this case, the plug-in imports only animation onto original geometries,
and does not add incoming Nulls to the existing scene. If you import the same
file into a new scene, the plug-in imports Nulls with the animation applied.

Convert NURBS surface to
This option lets you convert NURBS geometry into a mesh geometry during
the export process. This option is useful if you are exporting a scene to a
package that may not support NURBS.

By default, this option is set to “NURBS”, meaning the plug-in applies no
conversion and NURBS geometry is exported as NURBS.

FunctionOption

No conversion applied.NURBS

Converts geometry based on the NURBS
display settings.

Interactive display mesh

Converts geometry based on the NURBS
render settings.

Software Render Mesh

Preserve Instances
Activate the Preserve Instances option to retain Maya instances in the FBX
export. If you disable this option, instances are converted to objects.

Referenced containers content
Activate the Referenced containers content option so that the content of
referenced containers is not exported. In other words, the containers are
exported but their content is ignored.

NOTE You can only use the Referenced containers content option when you
export an FBX file. If you import this file back into Maya, the contents of your
containers are not imported.
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Disable this option to export the content of referenced containers. Doing this
means that they are no longer references, but instead become objects in the
exported FBX file. This is the default behavior.

NOTE This option has been added to the Maya FBX Plug-in for use with Maya
versions 2009 and later. For more information on Maya Containers, see the Maya
documentation.

Animation
Activate this option to export animation found in the scene.

Expand this option to access advanced animation options and features.

Extra options
Expand extra options to view additional options for export.

Use scene name
Normally, the Maya FBX Plug-in saves Maya scene animation in the FBX file
as Take 001. If you want the scene animation to instead be named for the
Maya scene, activate this option.

This option is deactivated by default, so the take is automatically named Take
001, and so on.

Remove single key
When you activate this setting, the exporter removes keys from objects on
export if the plug-in determines that the animation has only one key. When
two or more keys exist in the file, the keys are exported.

If you disable this option, the plug-in does not remove keys from the animation
on export.

NOTE This option is disabled by default.
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Why do I need this?

Sometimes, even though objects in a file contain no animation, they have a
single key assigned to them for use as a locator. If you do not need these single
keys in your file, you can reduce the file size by activating Remove single keys
to discard them.

Quaternion interpolation mode
Use the Quaternion interpolation mode menu to select how to export your
quaternion interpolations from the host application. Select from the following
three options:

Resample as Euler interpolation

This is the default conversion setting for quaternion interpolations.

This option converts and resamples quaternion interpolations into Euler curves
to ensure interoperability.

Retain quaternion interpolation

This option retains quaternion interpolation types during the export process.

NOTE Use this option when you export animation that has quaternion
interpolations. This option is only compatible with applications supporting this
interpolation type, such as Autodesk MotionBuilder. Also note that the resulting
animation will not be identical since quaternion evaluations are different in Maya
vs. MotionBuilder. Use the default option (Resample as Euler interpolation) to
obtain visual results identical to your animation in MotionBuilder, or other
applications.

Set as Euler interpolation

This option changes the interpolation type of quaternion keys to a Euler type,
without resampling the animation curves themselves.

NOTE Using this option results in the same number of keys, set as Euler types.
The visual result will be different since it is now evaluated as a Euler interpolation.
Use the default (Resample as Euler interpolation) option in order to obtain visual
results identical to your animation in MotionBuilder, or other applications.
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Bake animation
This option lets you Bake (or Plot) Animation at export time.

This bakes all unsupported constraints, including Maya-supported and FBX
constraints, into animation curves. You can then import these curves into
another application that does not support these Maya constraints.

By default the Maya FBX Plug-in takes the Start and End values automatically
from the current Timeline settings of the host application. You can manually
enter in a custom start, end, and step value to bake a specific section of time.

The Step value defines how many keys are created per frame, and has a value
of 1 by default. Setting a Step value of 2 for example, only bakes and exports
a key every other frame.

NOTE Bake Animation Start/End/Step values cannot be saved in presets. The FBX
plug-in always derived these values from the exported scene. For more see Preset
Bake Animation settings on page 125.
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Why do I want to do this?

If you have animation in a scene that has a small section that contains
unsupported constraints or controllers, you can use this setting to customize
the Maya FBX Plug-in export process to avoid resampling an entire scene
worth of animation data when only a small part of it is unsupported.

Resample All

Use the Resample All option to bake even the supported animated elements.
This is unlike the Bake animation on page 50 option which selectively bakes
unsupported elements only.

NOTE The Resample All option resamples animation using the host application’s
frame rate or Time setting.

The Resample All option reacts to the state of the Bake Animation option. If
Bake animation is activated, Resample All is also activated.

Deformed Models
Activate the Deformed Models option to export Skin and Blend Shape
deformations.

You can choose to export Skins and Bend Shapes specifically by expanding
Deformed Models to access individual options.

DescriptionOption

Activate this option to export all geometry
Blend Shapes used in your scene.

Blend Shapes

Activate this option to export all skin de-
formation into your scene.

Skins

Curve filters
The Curve filters let you apply animation filters to function curves during the
export process.
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Constant Key Reducer
Activate the Constant Key Reducer filter to remove redundant keys. Redundant
keys are keys that have the same value, which are equivalent to flat horizontal
interpolations on a curve. Redundant keys are often a result of a resampled
FCurve before filtering.

Before:

Resampled FCurve before filtering

After:

Filtered FCurve with redundant keys removed (based on Threshold
setting)

You can set specific thresholds for each type of transform. Translation
Precision, Rotation Precision, Scaling Precision, and Other. Other includes
transforms like Blend Shapes and custom attribute curves.

The default values are:
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Values represent generic units. This is why you may need to modify threshold
values in relation to the world scale of your scene, for example with very large
or small scale scenes.

If you use this filter to eliminate noise, for example, from motion capture
data, then you may need to modify values.

DescriptionSetting

Threshold for translation curves in generic
units.

Translation Precision

Threshold for rotation curves in generic
units.

Rotation Precision

Threshold for Scaling curves in generic
units.

Scaling Precision

Threshold for other curves in generic units.Other Precision

This option ensures that only “auto” key
types are filtered. Otherwise, keys with in-

Auto tangents only

terpolation values greater than a certain
threshold may get deleted.

NOTE The Maya FBX Plug-in converts all animation keys to User, which is not an
Auto auto tangent. To ensure that constant key reducing occurs, deactivate Auto
Tangents Only in the Constant Key Reducer options.
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Geometry cache file(s)
Activate this option to create a geometry cache file of a chosen selection set.
To use this option, create a selection set of the objects for which you want to
retain the vertex animation in Maya.

NOTE You must apply the set to the Objects Transform node and not the Shape
node.

By default, any Geometry cache files created are in .MC format. When you
activate this option, three files are generated:

■ an FBX file

■ an XML file

■ an MC file

The Maya FBX Plug-in stores the XML and MC files in a subfolder named after
the FBX file and has the suffix FPC (_fpc).

For example, if you export a scene containing a cube named pCube1 to the
FBX file myTest.fbx, you create the following files and folders:

■ myTest.fbx

■ myTest_fpc

■ pCubeShape1.xml

■ pCubeShape1.mc

The plug-in retains any MC geometry cache files that are already recorded
(within the selection set).

Use the Set menu to select an appropriate set to export the geometry cache
file.

When would I use this?

Use this option when you export nCloth deformations on an object to 3ds
Max.
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Constraints
Activate this option to ensure that certain supported constraints are exported
to FBX.

FBX supported constraints include:

■ Point

■ Aim

■ Orient

■ Parent

■ IK handle (including Pole Vector)

This option lets you export your constraints effectively without the need to
bake the animation first, if you are transferring to a package that which
supports these constraints, like MotionBuilder.

NOTE If you export your scene with the intention of importing it into a package
that does not support these constraints (such as 3ds Max), bake the animation
first. See Bake animation on page 50 for more information.

FBIK definition
Activate this option to include your FBIK definitions in the file on export.
This can be useful if you are transferring to MotionBuilder, which also supports
characters.

Cameras
Activate this option to export all cameras contained in the scene.

The Maya FBX Plug-in exports camera settings, but not render settings
associated to the camera with the file. This can change rendering results
depending on the source application used in comparison. For more information
on why this occurs, see Why are my cameras inconsistent? on page 122

NOTE When you export, Maya cameras are converted into FBX camera types for
interoperability.
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Lights
Activate this option to export all lights contained in the file. The Maya FBX
Plug-in exports and converts light types to ensure FBX interoperability.

The Maya FBX Plug-in supports Standard Point, Spot, and Directional light
types exported to FBX for Autodesk 3ds Max, Autodesk MotionBuilder, and
other Autodesk applications.

Embed media
Activate this option to include (or embed) all media associated with your scene
in the FBX file itself. For example, texture images.

Activate the Embed Media option to make the Maya FBX Plug-in include
(embed) associated media (textures, for example) within the FBX file, which
it then extracts to an .FBM folder at import. The Maya FBX Plug-in copies the
embedded media to a <fileName>.fbm folder in the same location as the FBX
file and is named after the FBX file. Since this media is contained within the
FBX file itself, this has an impact on file size. Therefore, use this option only
when you transport an FBX file to a location where the original media source
is no longer accessible by the receiver.

NOTE When you import an FBX file with embedded media, the embedded files
extract to a folder in the same location as the FBX file. If you do not have write
permission to create that new folder, the media files are Imported to the user's
temp folder, such as C:\Documents and Settings\<username>\Local
Settings\Temp.

If you disable the Embed Media option, the Maya FBX Plug-in stores the
relative and absolute paths of the associated media files at export time. This
causes problems if, for some reason, the path is no longer accessible. Make
sure that the associated media is accessible to ensure the proper import of
these media files.

NOTE If you export your file in ASCII format in FBX versions 2010 and earlier, no
textures are embedded. See Type on page 62.

Why do I want to do this?

Embed your media to ensure that all your textures are carried over and loaded
when you open the FBX file on another computer. You do not need to do this
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if you are working on a local machine or over a network database that ensures
that the paths to media are not changing.

Connections
Expand this section for options about exporting connections.

Input Connections
This option causes the Maya FBX Plug-in to export selected objects without
automatically exporting all related input connections. In Maya, when you do
an export selection to FBX, the Input Connections option appears in the Maya
FBX Exporter.

If this option is disabled, no input connections associated with the selected
object are exported during the export selection operation. If the option is
active, however, all associated input connections to the selected object are
exported.

This option is active by default, so the Maya FBX Plug-in includes any objects
that influence the selected ones.

Display Layers

NOTE The export of display layers occurs automatically and does not appear as
an option in the Maya FBX Plug-in user interface.

The Maya FBX Plug-in automatically exports Display Layers found in your
Maya scene to FBX. This lets you transfer display layers from Autodesk Maya
to 3ds Max, and so on.

The following Maya Display layer properties are supported by the Maya FBX
Plug-in:

■ Layer Membership List

■ Display Layer name

■ Level of Detail

■ Display types

■ Visibility
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■ Color

Advanced options

The Advanced Options section primarily contains additional options that let
you modify the default plug-in behavior. In most cases, you do not need to
modify these options to have a successful export. The section also holds
additional settings specific to the Collada file type.

Units
The Units option lets you view the conversion factor (scaling value) the plug-in
uses as well as modify the conversion units.

NOTE This does not change the System unit settings in Maya.

Automatic option
Activate the Automatic option if you want the Maya FBX Plug-in to
automatically identify and set the units of the destination file to match units
of the host application

When you activate Automatic, the Scene units converted to option is disabled,
although it shows the resolved unit & Scale Factor. If you disable the Automatic
option, the Scene units converted to option becomes available.

When Automatic is active, the File Units will match the system units, and the
plug-in applies no conversion. The displayed Scale Factor is 1.0 in this case.
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Scale Factor
Displays the conversion value or Scale Factor that the plug-in applies to the
entire scene during export.

By default, the Maya FBX Plug-in uses the system units set in the host
application to determine what units to use to export the FBX file. This means
that the default export Scale Factor is always 1.0, and the plug-in applies no
unit scale conversion during the export process.

You can modify what units the Maya FBX Plug-in uses to export your scene
if you change the File units converted to option. If you change the File units
converted to option, you modify the Scale Factor value and units applied to
the exported data.

Scene units converted to
Use this menu to specify the units to which you want to convert your exported
scene. Modifying this setting directly affects the Scale Factor value applied to
the exported data.

The plug-in determines the default units by looking at the Maya System Units
option in the Window > Settings/Preferences > Preferences > Settings category.
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In the FBX UI, the displayed Scale Factor uses the FBX Unit setting for its
calculation. The plug-in determines the FBX Unit setting from the host
application system units.

On export, the plug-in applies no default scaling since the export and system
units match. This results in a Scale factor of 1.0.

NOTE Verify the system units your Maya scene uses so that you can control
whether the plug-in needs to scale your scene. This way, it exports with the units
you want. Maya lets you change the System Units without affecting the scale of
your scene. Changing the system unit in Maya avoids scaling on export when not
required.

Example

If you export a file that is in the same Unit setting as the System Units of your
Maya scene, there is a match of units and the displayed Scale Factor is 1.0. No
scale conversion is applied.

Axis conversion
The Maya FBX Exporter has two options for Axis Conversion in the UI. Y-up,
or Z-up.

By default, the FBX Exporter always exports the Up Axis of the Host
application. For Maya, this means that all scenes are exported with a Y-up
world axis.

You can export your scene to a Z-up axis if the destination application does
not support the Y-up world axis and cannot convert the Y-up world axis of
your scene.
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NOTE The FBX Exporter applies Axis Conversions only to root elements of the
outgoing scene. If you have animation on a root object that must be converted
on export, these animation curves are resampled to apply the proper axis
conversion. To avoid resampling of these animation curves, make sure to add a
Root Node (dummy object) as a parent of the animated object in your scene,
before you export to FBX.

UI
These options let you set display options of the UI. This lets you show or hide
the Warning Manager and FBX UI windows.

You can customize these display options, save them as a new Preset, and share
this preset file. See the Creating a custom preset on page 27 section for more
information.

Show/Hide Warning Manager
This option lets you disable the Warnings and Errors dialog box that appears
during the export process. The Warning Manager is active by default.

What is the difference between an Error and a Warning?

The Maya FBX Plug-in uses errors and warnings to alert you of conversions
and potential problems during the export process.

When something unexpected occurs during the conversion, the plug-in reports
an error. This error occurs when the plug-in encounters an unknown behavior
and the conversion is going to produce an unexpected result.

When the plug-in must apply a conversion to the source data for it to be in
a format that the destination application can read, the Maya FBX Plug-in
reports a warning. This warning is not the indication of a problem, but instead
exists to provide a report of conversions that the plug-in has applied to the
incoming data.

Generate log data
Deactivate the Generate log data option if you do not want warning and error
information written to the log. However, if you do deactivate this option, the
FBX Exporter/Importer does not write log data (such as errors and warnings,)
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to the generated log file. However, the file name and time stamp are still
recorded in the log.

The Maya FBX Plug-in stores log files with the FBX presets, in C:\My
Documents\Maya\FBX\Logs.

Why do I want to do this?

Occasionally, some batch imports/exports create very large warning/error files,
and in this case you might want to disable this option.

Normally, it is recommended to leave the Generate log data option active,
which is the default, as this helps you identify problems with file conversions.

Log files are important for tracking errors and warnings on export. It is not
recommended to deactivate this option when you export a series of files, for
example, in an automation or batch export because you will not receive any
feedback about any issues that concern files during export. This lack of feedback
can make it difficult to identify problem files which, in turn, makes diagnosing
problems difficult.

TIP Because log data is appended to the same log file, after a while the size of
this file become large. It is a good practice to delete the log file after a few exports,
or before processing batch export or import.

FBX file format
This section lets you determine what form you want your FBX file to take.

Type
Save your FBX file as one of these two types, Binary or ASCII. While binary is
the normal format for FBX files, ASCII files give you a plain text version of
the file format, which lets you search the file for information retrieval.

FunctionMode

Activate this option to save the FBX file in
the standard format.

Binary
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FunctionMode

Activate this option to save the FBX file in
ASCII format.

NOTE If you export your file to ASCII
format in FBX versions 2010 and earlier,
you cannot embed media.

ASCII

FBX version
Expand the FBX Version menu to select an FBX version.

The following table lists the different versions available for you to select from
the FBX exporter.

DescriptionVersion

Select this FBX version to export a file that
is compatible with Autodesk 2011 applica-

FBX 2011

tions and 2011 FBX plug-ins. This is the
default FBX version.

Select this FBX version to export a file that
is compatible with Autodesk 2010 applica-

FBX 2010

tions, 2010 FBX plug-ins and MotionBuild-
er 2009..

Select this FBX version to export a file that
is compatible with Autodesk 2009 applica-
tions and 2009 FBX plug-ins.

FBX 2009

Select this FBX version to export a file that
is compatible with Autodesk 2006 FBX

FBX 2006

plug-ins and MotionBuilder 7.5, 7.0, and
6.0. .

When do I use this?

You do not need to change this option if you are using the latest FBX Plug-ins
in the source and destination applications. You only need to use this option
if you plan to import your file using an older plug-in version.
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For example, if you want to export from Maya 2011 and import to Maya 2009
using the latest FBX 2011 versions of the plug-ins in both applications, you
do not need to change the export FBX version. The file is compatible when
you use the FBX 2011 versions of the plug-in.

Information

The Information rollout contains data about the Maya FBX Plug-in as well as
buttons you can use to check for more recent versions of the software and
accessing the Maya FBX Plug-in Help.

Web Updates

Click the Web Updates button to make sure that you are using the latest
version of the Maya FBX Plug-in. This function searches the Autodesk web
site to check if there is a newer version of the plug-in that you are currently
using. See Web updates
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Help

Click the Help button to launch the Maya FBX Plug-in user documentation.

Collada
The Collada options only appear in the UI when you select the DAE_FBX file
type from the file browser when you export.

NOTE When you export in Collada format, textures are not embedded, even
when the Embed Textures option is activated. See Embed media on page 56.

Triangulate

This option automatically tessellates the exported polygon geometry.
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Single matrix

This option ensures that there is only a single animation matrix for each
node/object by baking all animation matrices into one.

Frame Rate

Use this field to set the frame rate of the scene on export.

NOTE The Maya FBX Plug-in does not support Lines or Linestrip nodes.

NOTE The Smoothing Groups option in the Collada importer does not import
Smoothing Groups from the FBX file. Instead, when you activate this option, the
Importer creates the Smoothing Groups during the import process. The Collada
importer must create Smoothing Groups on Import because the FBX Collada
exporter does not export Smoothing Groups data from 3ds Max. If you disable
the Smoothing Groups option, no Smoothing Groups are generated by the
Importer.
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Import

This chapter contains information about options you can use in the Maya FBX Plug-in Importer
functions that appear to the right of the Maya Import window.

Maya Import dialog box A. FBX Import options

Importing FBX files into Maya
This section describes how to import files using the Maya FBX Plug-in:

To import an FBX file:

1 Launch Maya.

5
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2 Select File > Import. The File Import dialog box appears. Locate the FBX
file you want to import.

3 Select FBX from the File of Type menu.

NOTE If you do not see the FBX file extension in the File of Type menu,
activate fbxmaya.mll in Maya's Plug-in Manager.

Maya Import dialog box A. FBX options

4 The FBX Import options appear at the right of the Maya Import dialog
box.

68 | Chapter 5   Import



Import options

5 Set the import options you want to use or select a preset from the Presets
menu. The Autodesk Media and Entertainment preset contains the best
balance of options for a general animation workflow. Use the Autodesk
MotionBuilder preset if you are using a Maya to MotionBuilder back to
Maya workflow.

See Presets on page 70 for more information about the Autodesk presets
and for information about import options and which are appropriate for
you, review the Import on page 67 section.

6 Click Import in the Maya Import dialog box.

7 If conversions or errors occur during the import process, the Warning
Manager reports them at the end of the import process. See Show/Hide
Warning Manager on page 87 for information about the Warning
Manager.
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NOTE There is a difference between “Errors” vs. “Warnings”. The plug-in
reports an error when something unexpected occurs. When the plug-in
reports an error, it indicates that the consequences of that error are unknown.
Warnings inform users when the plug-in applies conversions to the source
data to convert the data into a format that the destination application can
read.

File type specific options
These settings concern what gets included with your file on import.

Presets

The Maya FBX Plug-in includes the following import workflow presets:

■ Autodesk Media and Entertainment

■ Autodesk MotionBuilder

Selecting a preset

Choose your preset by selecting it from the Current Preset menu in the File
Type Specific Options rollout of the Maya FBX Plug-in.
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Current Preset menu

DescriptionPreset

The Autodesk Media and Entertainment
preset contains the most options since it

Autodesk Media and Entertainment

contains the optimal settings for most an-
imation workflows. All available options
are visible in the UI so you can access and
customize them.

Use the Autodesk MotionBuilder preset if
you are using a Maya to MotionBuilder

Autodesk MotionBuilder

back to Maya workflow. This preset uses
the Constraints and FBIK Definition options
set for optimal Character animation using
Maya and MotionBuilder.
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DescriptionPreset

User Defined preset label displays
whenever you modify a setting that is dif-
ferent from the preset default.

User Defined

Editing presets

If you change a preset, the preset field displays User defined, to show that the
preset differs from its default state. You can find the user-defined states in a
temporary file so that the settings are the default the next time you use the
plug-in.

You can also save your settings is a custom preset. See Creating a custom preset
on page 27.

Statistics
The Statistics window lets you view relevant meta information about the
incoming (FBX) file and system (application) settings. Information varies
depending on what is in the file.

NOTE Sometimes statistics information is hidden below the window edge; use
the scroll bar to view it.

File name

Displays the name of the file.

File directory

Displays the location of the file directory.
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File version

Displays the FBX file format version of the file.

File creator

Displays the name and version of the application that created the file.

File creation time

Displays the date and time that the file was created.

File axis direction

Displays the up-axis of the file.

File units

Displays the unit of measurement in the file.

System axis direction

Displays what the up-axis is in the current application.

System units

Displays the unit of measurement used in the current application.

File content

Displays the contents of the file.

Include
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The Include rollout lets you decide what data and conversions to apply to
your scene at import from a host application.

File Content

Use the File content menu to select how to import the content of your file
into the host application.

Select from the following three options:

DefinitionOption

This option adds the content of the FBX
file to your scene and updates existing

Add and update scene elements

elements. Use this option to add non-exist-
ent elements to the scene, and replace the
animation of elements already present in
the host application. Select this setting to
combine the effects of the Add to scene
and Update scene elements options.

NOTE Add and update scene elements is
the default setting for the Autodesk Media
& Entertainment preset.

This option updates the existing elements
in your scene. Use this option to update

Update Scene Elements

(exclusive merge) elements that already
exist in the host application. Update scene
elements does not create new elements in
the host application.

This option adds all content of the FBX file
to the host application. If elements exist in

Add to Scene

the host application, the plug-in duplicates
them.

Geometry
Expand the Geometry rollout to access options related to importing geometry
into your scene.
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Unlock Normals
Activate this option to unlock geometry normals and force Maya to re-compute
the edge continuity.

NOTE Normals are automatically unlocked for all deformed geometry imported
into Maya.

When you disable the Unlock Normals option, Maya imports the locked
geometry normals as they were represented by the application that generated
the FBX file.

NOTE Locked normals can create shading issues for geometry if a deformer is
applied after import. Unlocking geometry normals resolves this.

Maya fully smooth or faceted geometry

If you activate the Unlock Normals option, the object imports with unlocked
normals.

If you then unlock the normals faceted edges may appear. This occurs when
importing from 3ds Max. If this happens, select the object in Maya and apply
the Maya soften edge function to smooth the object.

If you disable Unlock Normals, the object imports with the correct look and
the normals will be unlocked.

Maya combination of soft and hard edges

With the Unlock Normals option activated, the object imports correctly with
its normals locked. If you intend to deform this geometry you must to unlock
the normals, but if you do this the object becomes hard edged in Maya.

Re-import the FBX file with the Unlock Normals option activated to resolve
this issue.

If you disable the Unlock Normals options, the object imports correctly with
unlocked normals.

Maya deformations

When you activate Unlock Normals, Deformed geometry always imports
unlocked. The unlock function does not apply in this case.

If you do not have the Unlock Normals option activated, deformed geometry
imports unlocked. The unlock function does not apply in this case.
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Maya smooth mesh preview

If you activate Unlock Normals, objects imported with smooth meshes import
with unlocked normals

If you disable the Unlock Normals option, the normals of objects with smooth
meshes import locked.

Combine per-vertex Normals
Activate this option to combine geometry vertex Normals.

Common uses of this option include reverting the Split per-vertex Normals
option of the FBX Export window. For more information regarding this
workflow see Split per-vertex Normals on page 44.

When you use the Combine per-vertex Normals option in the FBX Importer,
the Maya FBX Plug-in performs the inverse operation of the Split per-vertex
Normals option in the FBX Export window. This can result in incorrect UV
texture maps (see the note below).

If you are not using a merge-back workflow (merging FBX into an existing
scene) this option might result in incorrect UV mapping when you re-import
the FBX file into Maya. Import your FBX file into to your original Maya scene
to avoid geometry UV issues with split geometry.

NOTE Using this option permanently alters any UV maps applied to geometry.
The plug-in properly re-assigns the UVs to the newly split geometry. There is a
limitation in regards to UVs, when importing this geometry into an empty Maya
scene, using the Combine per-vertex Normals option in the FBX Importer, as it
may result in incorrect UV assignments.

Animation
Activate this option to import animation found in the scene.

Expand this option to access advanced animation options and features.

Extra options
Expand this section to view additional import options.
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Animation Take
Displays the current animation take in the FBX file.

If no animation take exists in the file, the field shows a No animation message.

If several animation takes exist in the file, the currently selected take is
displayed in the field.

You can change the selected take of animation by selecting another take from
the menu. The Maya FBX Plug-in lists all available takes of animation contained
in the file.

NOTE You can only select and import a single take of animation at a time.

Fill timeline
Activate this option when you want to update the application timeline by the
animation range in the incoming FBX file. “Animation range” refers to the
first and last keys of animation contained in the file.

Bake animation layers
When the Bake Animation Layers option is active, the plug-in collapses all
layers into the base layer. If you disable the Bake Animation Layers option,
all the layers in the FBX file will be imported.

Optical markers
Activate this option to convert optical markers contained in the file into
dummy objects on import.

If you disable this option, the import process ignores this data.

Optical markers normally come from motion capture data, as a cloud of
animated points or markers. The Maya FBX Plug-in does not import the
animation as the data type is incompatible. However, the Maya FBX Plug-in
converts optical data into a cloud of static null objects in Maya.

TIP If your optical data originates from MotionBuilder, you can set the state of all
optical markers to Done in MotionBuilder which lets you import the animation
data as curves in Maya.
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Why do I want to do this?

This option is useful if you need to import optical data that is stored within
an FBX file. For example, if you wanted to send an FBX file containing optical
data that someone needs to use in Maya but they do not use MotionBuilder,
you can activate this option to use the FBX file format to store optical data.

Quaternion interpolation mode
This is the default conversion setting for quaternion interpolations.

This option converts and resamples quaternion interpolations into Euler curves
to ensure interoperability.

Resample as Euler interpolation

This is the default conversion setting for quaternion interpolations.

This option converts and resamples quaternion interpolations into Euler curves
to ensure interoperability.

Retain quaternion interpolation

This option retains quaternion interpolation types during the import process.

TIP Use this when you import animation that has quaternion interpolations. This
is only compatible with applications supporting this interpolation type, such as
Autodesk MotionBuilder. Also, the resulting animation is not identical since
quaternion evaluations are different in Maya and MotionBuilder. Use the default
(Resample as Euler interpolation) option in order to obtain visual results identical
to your animation in MotionBuilder, or other applications.

Set as Euler interpolation

This option lets you change the interpolation type of quaternion keys to a
Euler type, without resampling the animation curves themselves.

TIP Using this option results in the same number of keys, set as Euler types. The
visual result will be different since it will now be evaluated as a Euler interpolation.
Use the default (Resample as Euler interpolation) option to obtain visual results
identical to your animation in MotionBuilder, or other applications.
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Protect driven keys
Activate this option to prevent any incoming animation from overwriting
channels with driven keys. Maya has special driven keys that link one attribute
value to another object attribute. These keys are exclusive to Maya and are
not supported by FBX. When this option is active, the Maya FBX Plug-in
prevents the disconnection or overwrite of attributes that use driven keys.

If the option is active, the driven keys are protected and no incoming
animation is applied to the driven channels.

If the option is not active, the driven keys are discarded and the incoming
animation is applied to the driven channels.

Deforming elements to joints
Activate this option to convert deforming elements into Maya joints. This
option was originally provided because Maya did not support locator elements
(that is, transform nodes that are not joints,) within a joint chain.

If this option is not active, all elements other than joints being used to deform
are converted to locators. See Cluster import on page 126 for information about
cluster problems.

Update pivots from Nulls
Activate this option only when you import older (pre-MotionBuilder 5.5) FBX
files that contain an animated joint hierarchy, for example, an animated
character.

This option lets you assign the rotation transformation of the null (or joints)
elements in the hierarchy that are used as pre- and post-rotation to the joint
orient and the rotate axis of the original node.

The pre-rotation and post-rotation nodes are then deleted. Older files created
with the Export Pre/Post Rotation as Nulls option are merged back to the
original Maya setup.

Geometry cache file(s)
Activate this option to import FBX-exported geometry cache data during the
FBX import process.
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The Maya FBX Plug-in generates three files when you export Geometry cache
files using FBX:

■ an FBX file

■ an XML file

■ an MC file

The plug-in stores XML and MC files in a subfolder named after the FBX file
and has the suffix FPC (_fpc).

For example, if you export a scene containing a cube named pCube1 to the
FBX file myTest.fbx, you create the following files:

■ myTest.fbx

■ myTest_fpc

■ pCubeShape1.xml

■ pCubeShape1.mc

Deformed Models
Activate the Deformed Models option to import Skin and Blend Shape
deformations.

You can choose to import Skins and Blend Shapes specifically by expanding
Deformed Models to access individual options.

You also have the option to Pre-normalize weights. Pre-normalizing weights
normalizes the weight assignment of skin deformations so that smooth skin
weights add up to one.

DescriptionOption

Activate this option to import all skin de-
formation into your scene.

Skins

Activate this option to import all geometry
Blend Shapes into your scene.

Blend Shapes

Activate this option to normalize weight
assignment.

Pre-Normalize Weights
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What is pre-Normalizing?

During the import process, the Maya FBX Plug-in can pre-Normalize weights
to ensure that every vertex on a skinned mesh has a weight no less than a
total of 1.0. You can have many joints that influence a single vertex, however,
the percentage of each deforming joint always equals a sum total of 1.0.

Why do I want to do this?

Use this function if you import older FBX files that result in abnormal mesh
deformations.

Constraints
Activate this option to ensure that certain supported constraints contained
in the FBX file are imported into Maya.

If this option is not active, no supported constraints are imported.

FBX supported constraints include:

■ Point

■ Aim

■ Orient

■ Parent

■ IK handle (including Pole Vector)

FBIK definition
Activate this option to import your FBIK character definition into Maya.

If this option is not active, the rig is imported without characterization.

Activating this option can be useful if you import FBX files from Maya or
MotionBuilder.

Cameras
Activate this option to import all cameras contained in the file.
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The plug-in imports camera settings, but not render settings. This can change
rendering results depending on the source application used in comparison.
See Why are my cameras inconsistent? on page 122 for more about render
settings limitations.

The plug-in saves cameras as FBX types in the FBX file for interoperability.
This means they must convert into Maya camera types on import.

Lights
Activate this option to import all lights contained in the file. The Maya FBX
Plug-in exports and converts light types to ensure FBX interoperability.

FBX supports Standard Point, Spot, and Directional light types from Autodesk
3ds Max, Autodesk MotionBuilder, and other Autodesk applications.

Advanced options

Use the Advanced Options to customize your general settings and import
process.

Units
The Units option lets you view the conversion factor (scaling value) the plug-in
uses as well as modify the conversion units.
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This option automatically identifies, sets, and converts units of the incoming
file to match units of the host application.

If this option is active, but the File Units match the system units, there is no
need for scale conversion and the plug-in applies no conversion. The displayed
Scale Factor is 1.0 in this case.

NOTE This conversion affects only incoming data. This conversion does not change
the settings in Maya.

Automatic
Activate the Automatic option if you want the Maya FBX Plug-in to
automatically identify, set, and convert units of the incoming file to match
units of the host application.

When you activate Automatic, the Scene units converted to option is disabled,
although it shows the resolved unit and scale factor. If you disable the
Automatic option, the Scene units converted to option becomes available.

When Automatic is active but the file units match the system units, there is
no need for scale conversion and the plug-in applies no conversion. The
displayed Scale Factor is 1.0 in this case.

NOTE This conversion affects only incoming data. This does not change the
settings in Maya.

Scale Factor
Displays the conversion value or Scale Factor that the plug-in applies to the
entire incoming scene.

The Maya FBX Plug-in compares the units used in the host application with
the units used in the file imported to determine the Scale Factor value. The
plug-in then proposes a unit conversion that matches the system units in the
host application. The displayed Scale Factor is the result of this calculation.

For example, if you import a scene from software that used centimeters as the
working units to software that uses feet as units, the Scale Factor will be 2.54.

This option is always active, but if your File Units match the system units, the
plug-in does not apply a scale conversion. No conversion is applied. The
displayed Scale Factor is 1.0 in this case.
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NOTE If you change the File Units Converted to: option, you can modify the Scale
Factor value applied to incoming data.

File Units converted to
Use this menu to specify the units to which you want to convert the file.
Modifying this setting directly affects the Scale Factor value applied to the
incoming data.

The Maya FBX Plug-in looks at the Settings/Working Units in the Preferences
window of Maya.

The displayed Scale Factor uses this unit setting for its calculation.

This automatic behavior ensures that the plug-in respects units, and proper
scaling is applied by default.

NOTE  Verify the System Units your Maya scene uses so that you can control
whether the Maya FBX Plug-in needs to scale your scene.
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Example

If you import a file that is in the same unit setting as the Working Units of
your Maya scene, there is a match of units and the plug-in displays “1.0” as
the Scale Factor. No scale conversion is applied.

If the units do not match and your Maya scene is empty and/or changing the
System Units is not a concern, change the Maya System Units to match the
File Units used in the incoming file before you start to import. This results in
a match of units, Scale Factor of “1.0”, and no scale conversion is applied.

For example, if you import a file that is in centimeters into a Maya scene set
to inches, it results in a Scale Factor of 0.3937008. In this case, the incoming
data is scaled down to match the scene's unit system.

NOTE If the Scale Factor is 1.0, no scaling is applied. If the Scale Factor is greater
than 1.0, the incoming data is scaled up. If the factor is smaller than 1.0, the
incoming data is scaled down.
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If, with the previous example, you do not want to change the System Units
of your Maya scene and do not want the plug-in to scale your incoming data,
you have another option:

Change the File Units Converted To option to match the File Units. This
results in a Scale Factor of “1.0”, and no scaling is applied, even though units
do not match between the file and the Maya System Units.
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UI
These options let you set display options of the UI. This lets you show or hide
the Warning Manager.

You can customize these display options, save them as a new preset, and share
this preset file. See the Editing presets on page 72 section for more information.

Show/Hide Warning Manager
This option lets you disable the Warnings and Errors dialog box that appears
during the import process. The Show Warning Manager option is active by
default.

What is the difference between an Error and a Warning?

The Maya FBX Plug-in uses errors and warnings to alert you of conversions
and potential problems during the import process.

When something unexpected occurs during the conversion, the plug-in reports
an error. This error occurs because the Maya FBX Plug-in encounters an
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unknown behavior and the conversion is going to produce an unexpected
result.

When the Maya FBX Plug-in must apply a conversion to the source data for
it to be in a format that the destination application can read, a warning is
reported. This warning is not the indication of a problem, but instead exists
to provide a report of conversions that have been applied to the incoming
data.

Generate log data
Deactivate the Generate log data option if you do not want warning and error
information written to the log. However, if you do deactivate this option, the
file name and time stamp are still recorded in the log.

Why do I want to do this?

Normally, it is recommended to leave the Generate log data option active,
which is the default, as this helps you identify problems with file conversions.

Occasionally, some batch import/export create very large warning/error files,
and in this case you might want to disable this option.

Performance
The Performance options let you detect performance issues with your file.

Test Meshes for Bad Polygons

Activate this option when you want to test your mesh objects for polygons
that may have issues.

Axis conversion
The FBX Importer does not have an Axis Conversion option in the UI. Only
the FBX Export window has this option exposed in the UI.

This is because the Maya FBX Plug-in calculates and applies the Axis
Conversion automatically upon import.
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What does the automatic conversion do?

The FBX Importer looks at the up-axis used in the host application. It then
compares this to the up-axis set in the incoming file. If both up-axes match,
the FBX Import window applies no conversion. If they do not match, the
importer applies a conversion to the imported data to match the host
application’s up-axis automatically.

NOTE The importer applies Axis Conversions only to root elements of the incoming
scene. If you have animation on a root object that must be converted on import,
these animation curves are resampled to apply the proper axis conversion.

Collada
If you select the DAE_FBX file type from the file browser when you import,
the Maya FBX Plug-in automatically uses the optimal DAE import settings.

Collada and Smoothing Groups

The Smoothing Groups option in the FBX Collada importer does not import
Smoothing Groups from the FBX file. Instead, when you activate this option,
the Importer creates the Smoothing Groups during the import process. The
Collada importer must create Smoothing Groups on Import because the FBX
Collada exporter does not export Smoothing Groups data from 3ds Max. If
you disable the Smoothing Groups option, no Smoothing Groups are generated
by the Importer.

Information
The information rollout contains information about the Maya FBX Plug-in.

Web Updates
It is important to use the latest Maya FBX Plug-in as each subsequent plug-in
contains numerous bug fixes and features. See Web updates on page 35 to
learn how to download a free update to the plug-in.

Information | 89



Help on FBX
Click the Help on FBX button in the Information rollout to access the Maya
FBX Plug-in documentation.

Information rollout: Help button
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Maya FBX Plug-ins
Workflows

The following are some tips for certain workflows that will provide optimal results.

IFFFS
Importing and Exporting Cameras

You can either import a camera you created and edited in Action, or import
one from another 3D application. Once a camera is imported, you can edit its
parameters, change its animation, and then export it back to the application it
came from.

Flame Cameras

Flame supports the import and export of 3D data saved in the FBX 3D format.
The FBX standard format provides a means for exchanging 3D data for scene
compositions—such as cameras—between tools and packages developed by
different manufacturers.

To export a camera to FBX format:

1 In Flame, select the camera you want to export.

2 In the Camera menu, click Export. The Export Camera file browser appears.

3 From the Export Type box, select Autodesk FBX.
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4 Select which elements of the FBX files you wish to export by clicking the
corresponding filter button.

To:Enable:

Rotate the exported camera by -90° on the
X-axis so that it is compatible with the co-
ordinate system of the 3D application.

Rotate Axis

Export the animated axes present in the
Action scene.

Export Axes

Export the 3D point cloud created by the
3D Tracker.

Export Point Cloud

5 Navigate to the location where you want to export the camera animation.

6 Enter a name for your exported camera in the file field.

7 Click Save.

Renaming strategy
When the Maya FBX Plug-in discovers objects or elements that have the same
name, a naming conflict occurs. The Maya FBX Plug-in compensates for this
by renaming the elements on import or export. The same is true for any upper-
and lower-case conflicts.

When does this happen?

This occurs when, for example, you export an FBX scene from 3ds Max that
contains two objects named “Box01”. The result in Maya is that the first object
called “Box01”, and the second object, originally called “Box01” as well, is
now named “Box01_ncl1_1”. This must happen because Maya does not support
objects with the same names.

The following is a description of what happens:

Redundant names

When the Maya FBX Plug-in finds multiple instances of the same name in
the scene, a symbolic code is used. The Maya FBX Plug-in can read older files,
although it no longer writes them this way.

The new suffix is then: _ncl1_x (where x is the instance number).
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Case conflicts

When the Maya FBX Plug-in finds upper- and lower-case conflicts in the names
of objects or elements in the scene, a more complex suffix is used to keep track
of which character was/is upper- or lower-case so it can be converted back on
import/merge.

The following suffixes are used to indicate the case:

SuffixSituation

_ncl2Indicates case

_ulXXXXTo depict characters that were originally
upper case and have become lower case

_luxxxx. (Where xxxx is a four-digit integer
representing the character position in the

To depict characters that were originally
lower case and have become upper case

string (bit-wise). For example, _ul5 indic-
ates that the first and third characters in
the string have been changed from upper
to lower case. A suffix can be made of the
combination of _ul and _lu sub-suffixes.)
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Maya MEL Scripting

This section contains scripts required for scripting with Maya MEL commands.

All of the Maya FBX Plug-in's MEL commands begin with the FBX prefix. When error
conditions are encountered, they will display error messages in the script editor window. The
MEL commands that are registered by the Maya FBX Plug-in are listed in the Plug-in Manager
information dialog box.

NOTE To use the following MEL commands, the Maya FBX Plug-in must be installed on
your computer.

Hiding the UI
If you are writing a script and want to prevent the FBX UI from appearing each
time a file is imported you can use a specific command:

FBXImport -file "c:/myfile.fbx";

This automatically suppresses the FBX UI on import.

Scripting commands
Use these script commands to list, query, or set FBX I/O Settings properties for
the Maya FBX Plug-in, including properties created with a plug-in extension.

NOTE The scripting commands do not affect the settings in the FBX Export/Import
Presets window.

The FBXProperty command lets you use every option available in the FBX
plug-in user interface.

7
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There is generally a scripting command that represents every option found
in the Maya FBX Plug-in. However, if an option is added at the last moment
and there is not yet a corresponding scripting command for it, you can use
FBXProperty to access the new unscripted option.

Another use for the FBXProperty command is if no scripting command exists
for you to use for a specific scripting workflow. With FBXProperty, you can
still access the command.

NOTE We recommend using the normal scripting command if one exists. But if
a command does not exist for an option, you can use the FBXProperty to reach
it.

DescriptionCommand

Use this command to list all import and
export properties available. This command

FBXProperties

returns the property path, type, and cur-
rent value. If the property is an Enum, it
returns every possible value.

Use this command to set an import value
to true.

FBXProperty Import|IncludeGrp|Light -v
true

Use this command to query an import
value.

FBXProperty Import|IncludeGrp|Light -q

Use this command to set an export value
to true.

FBXProperty Export|IncludeGrp|Light -v
true

Use this command to query an export
value.

FBXProperty Export|IncludeGrp|Light -q;

All script commands and paths in this section are case sensitive, so it is good
practice to copy and paste them so you can have the exact path for the IO
Settings when querying for a list of properties and their path.

NOTE These script commands support only Integer, Double, Bool, and Enum
properties
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Export commands
The following are the Maya MELscript commands as they would appear in
the FBX Exporter interface:

ScriptCommand

FBXLoadExportPresetFile on page 117Presets

<none>Statistics

FBXExportDxfDeformation on page 102Include: Geo-
metry

FBXExportAnimationOnly on page 98FBXExportBakeComplexAn-
imation on page 99FBXExportBakeComplexEnd on page 99FBXEx-

Include: Anima-
tion

portBakeComplexStart on page 99FBXExportBakeComplexStep on
page 100FBXExportShapes on page 105FBXExportSkins on page
106FBXExportCacheFile on page 100FBXExportConstraints on page
101FBXExportQuaternion on page 104FBXExportApplyConstantKeyRe-
ducer on page 98

FBXExportCameras on page 100FBXExportLights on page 104FBXEx-
portEmbeddedTextures on page 102

Include: Other

FBXExportScaleFactor on page 105FBXConvertUnitString on page
115

Advanced: Units

<none>Advanced: UI

FBXExportInAscii on page 103FBXExportFileVersion on page 102Advanced: FBX
File Format

FBXExportAxisConversionMethod on page 98FBXExportCollada-
FrameRate on page 101FBXExportColladaSingleMatrix on page
101FBXExportColladaTriangulate on page 101

Advanced: Other

FBXExport
FBXExport -f [filename] [-s]

Exports the specified file.
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Add the -s flag if you want to change the export process so it exports the
selected objects instead of an “export all” operation.

For example:

FBXExport -f myfile.fbx -s

FBXExportAnimationOnly
FBXExportAnimationOnly -v [true|false]

FBXExportAnimationOnly -q

Use this script to export only animation. See Animation on page 48 for more
information.

FBXExportApplyConstantKeyReducer
FBXExportApplyConstantKeyReducer -v [true|false]

FBXExportApplyConstantKeyReducer-q

This is the script equivalent of the Constant Key Reducer on page 52 for more
information.

True

Filters FBX animation FCurves through a Constant Key Reducer. This eliminates
constant keys on a FCurve and helps to reduce the size of resampled FCurves,
especially Scale.

False

Setting this command to False ensures that the animation data is not filtered.

FBXExportAxisConversionMethod
FBXExportAxisConversionMethod [none|convertAnimation|addFbxRoot]

FBXExportAxisConversionMethod -q

This command lets you set an export conversion method. See Axis conversion
on page 60 for more information.
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None

No conversion takes place and the exported data is unaffected.

Convert animation

Recalculates all animation FCurves so their values reflect the new World
system.

Add FBX_Root node

Adds a transformation node to the top of the scene to contain the
transformations needed to transport the data into the new World system. This
option facilitates backward compatibility as it generates the FBX file the same
way as earlier releases of the plug-in.

NOTE If the plug-in does not detect a need for the conversion, no Fbx_Root node
is added.

FBXExportBakeComplexAnimation
FBXExportBakeComplexAnimation -v [true|false]

FBXExportBakeComplexAnimation -q

This command is the script equivalent of the Bake animation option. See Bake
animation on page 50.

FBXExportBakeComplexEnd
FBXExportBakeComplexEnd -v [int]

FBXExportBakeComplexEnd -q

This command is the script equivalent of the End field in the Bake animation
option. The passed value is an integer number. See Bake animation on page
50 for more information.

FBXExportBakeComplexStart
FBXExportBakeComplexStart -v [int]

FBXExportBakeComplexStart -q
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This command is the script equivalent of the Start field in the Bake animation
option. The passed value is an integer number. See Bake animation on page
50 for more information.

FBXExportBakeComplexStep
FBXExportBakeComplexStep -v [int]

FBXExportBakeComplexStep -q

This command is the script equivalent of the Step field in the Bake animation
option. The passed value is an integer number. See Bake animation on page
50 for more information.

FBXExportBakeResampleAll
FBXExportBakeResampleAll -v [true|false]

FBXExportBakeResampleAll - q

This command is the script version of the Resample All option in the FBX
Exporter. See Resample All on page 51.

FBXExportCacheFile
FBXExportCacheFile -v [true|false]

FBXExportCacheFile -q

This command is the script version of the Geometry Cache file(s) option in
the FBX Exporter. See Geometry cache file(s) on page 54.

NOTE You must apply the set to the Objects Transform node and not the Shape
node.

FBXExportCameras
FBXExportCameras -v [true|false]

FBXExportCameras -q

Use this function to either include or exclude cameras in your FBX export.
See Cameras on page 55 for more information.
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FBXExportCharacter
FBXExportCharacter -v [true|false]

FBXExportCharacter -q

Use this function to either include or exclude Character definition in your
export.

FBXExportColladaFrameRate
FBXExportColladaFrameRate [float]

FBXExportColladaFrameRate -q

This function is the script equivalent of the Collada Frame Rate on page 66
option.

FBXExportColladaSingleMatrix
FBXExportColladaSingleMatrix [true|false]

FBXExportColladaSingleMatrix -q

This command is the script equivalent of the Collada Single matrix on page
66 option.

FBXExportColladaTriangulate
FBXExportColladaTriangulate [true|false]

FBXExportColladaTriangulate - q

This command is the script equivalent of the Collada Triangulate on page 65
option

FBXExportConstraints
FBXExportConstraints -v [true|false]

FBXExportConstraints -q

Causes all the constraints defined in the Maya scene to be either included or
excluded from the exported FBX file. See Constraints on page 55.
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FBXExportDxfTriangulate
FBXExportDxfTriangulate [true|false]

FBXExportDxfTriangulate -q

NOTE This command is for the Macintosh and Linux platforms only.

FBXExportDxfDeformation
FBXExportDxfDeformation [true|false]

FBXExportDxfDeformation - q

NOTE This command is for the Macintosh and Linux platforms only.

FBXExportEmbeddedTextures
FBXExportEmbeddedTextures -v [true|false]

FBXExportEmbeddedTextures -q

True

Saves all textures in the FBX file. This command performs the same action as
the Embed Media option in the FBX Exporter window. See Embed media on
page 56.

FBXExportFileVersion
FBXExportFileVersion [version]

Where [version] is the following:

■ FBX201000

■ FBX200900

■ FBX200611

■ FBX200608

■ FBX200602_MB75
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■ FBX200508_MB70

■ FBX60_MB60

See FBX version on page 63 for more.

FBXExportGenerateLog
FBXExportGenerateLog -v [true|false]

FBXExportGenerateLog -q

Use this command to generate a log file on export. See Generate log data on
page 61 for more information.

FBXExportHardEdges
FBXExportHardEdges -v [true|false]

FBXExportHardEdges -q

Duplicates all vertices in the scene's meshes for each polygon connected to
them. The vertices’ normals are set accordingly, depending on whether they
are connected to a hard or smooth edge.

NOTE

This function allows MotionBuilder to display hard edges.

If two vertices are located exactly at the same position, a warning is issued, as
this causes unpredictable results when FBXImportHardEdges is set to True.

This command is the script version of the Split per Vertex Normals option in
the FBX Exporter. See Split per-vertex Normals on page 44.

FBXExportInAscii
FBXExportInAscii -v [true|false]

FBXExportInAscii -q

Use this function to export as an ASCII file. See Type on page 62 for more
information.
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FBXExportInputConnections
FBXExportInputConnections -v [true|false]

FBXExportInputConnections –q

Use this function to query the current value of the input connection option.
The function returns 0 for False, and 1 for True.

Use this function with the FBXExport on page 97 script if you are performing
an export of selected objects. Set False so that the input connections to selected
objects are not considered during export. The default value for this command
is True, which makes the plug-in include all the objects that influence the
selected ones.

This is the script equivalent of the Connections on page 57 option in the UI.

NOTE This command is ignored during the “Export All” process.

FBXExportInstances
FBXExportInstances -v [true|false]

FBXExportInstances -q

This is the script equivalent of the Preserve Instances on page 47 option in
the UI.

FBXExportLights
FBXExportLights -v [true|false]

FBXExportLights -q

Use this function to either exclude or include lights in the exported FBX file.
See Lights on page 56 for more information.

NOTE This option is activated by default.

FBXExportQuaternion
FBXExportQuaternion -v [quaternion|euler|resample]

FBXExportQuaternion -q

104 | Chapter 7   Maya MEL Scripting



Use the quaternion interpolation script to select how to export your quaternion
interpolations from the host application.

FBXExportQuickSelectSetAsCache
FBXExportQuickSelectSetAsCache –v “setName”

FBXExportQuickSelectSetAsCache –q

This command stores the setName as the set to be used when exporting the
cache file.

This command does not validate the received string. However, if the string
used here does not correspond to an existing (and valid) set in the Maya scene,
the cache export fails.

FBXExportReferencedContainersContent
FBXExportReferencedContainersContent -v [true|false]

FBXExportReferencedContainersContent -q

This command is the script version of the Referenced Containers Content
option in the FBX Exporter. See Referenced containers content on page 47.

FBXExportScaleFactor
FBXExportScaleFactor [float]

FBXExportScaleFactor -q

This command is the script version of the Scale Factor field in the FBX Exporter.
See Scale Factor on page 59 for more information.

FBXExportShapes
FBXExportShapes -v [true|false]

FBXExportShapes -q

Use this function to either exclude or include shape deformations with your
FBX file. See Deformed Models on page 51 for more information.

NOTE This option is on by default.
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FBXExportSmoothingGroups
FBXExportSmoothingGroups -v true|false

FBXExportSmoothingGroups -q

This command is the script version of the Smoothing Groups option in the
FBX Exporter. See Smoothing Groups on page 43 for more information.

FBXExportSmoothMesh
FBXExportSmoothMesh -v true|false

FBXExportSmoothMesh -q

Use this function to export the subdivision level of the mesh.

FBXExportSkins
FBXExportSkins -v [true|false]

FBXExportSkins -q

Use this function to either exclude or include skin deformations in your FBX
file. See Deformed Models on page 51 for more information.

NOTE This option is on by default.

FBXExportUpAxis
FBXExportUpAxis [y|z]

FBXExportUpAxis -q

This command lets you define the up axis in your FBX file. The up axis is the
global axis that points upwards. See Axis conversion on page 60 for more
information.

By default, the up axis in Maya is the Y axis.

Y

Sets the up axis to Y-up. This setting is the default.
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Z

Sets the up axis to Z-up.

FBXExportUseSceneName
FBXExportUseSceneName -v [true|false]

FBXExportUseSceneName -q

This command is the script version of the Use scene name on page 48 option
in the FBX Exporter.

FBXExportTangents
FBXExportTangents -v [true|false]

FBXExportTangents -q

This command is the script version of the Tangents and Binormals on page
45 option in the FBX Exporter.

FBXImport
FBXImport -f [filename] -t [take index]

Imports the file specified in [filename] and the take specified in [take index].

The file imported is the one accessible for take querying after the execution
of the command.

Specify the appropriate take number to load the corresponding take. If you
specify 0, the plug-in imports no animation. (This is the same as if you select
No Animation from the menu in the Maya FBX Plug-in user interface.)

If you specify -1, the plug-in retrieves the last take in the take array. The plug-in
considers any number of takes greater than the amount of takes contained in
the file or any negative value less than -1 to be invalid. If this occurs, a No
such take error displays.

FBXImportAxisConversionEnable
FBXImportAxisConversionEnable -v [true|false]
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FBXImportAxisConversionEnable -q

This command is the script version of the Axis conversion option in the FBX
Importer. See Axis conversion on page 88 for more information.

FBXImportCacheFile
FBXImportCacheFile -v [true|false]

FBXImportCacheFile -q

This command is the script version of the Import geometry Cache file(s) option
in the FBX Importer. See Geometry cache file(s) on page 79 for more
information.

FBXImportCameras
FBXImportCameras -v [true|false]

FBXImportCameras -q

Use this script to either import or exclude cameras with your FBX file. See
Cameras on page 81 for more information.

NOTE This function is on by default

FBXImportCharacter
FBXImportCharacter -v [true|false]

FBXImportCharacter -q

Use this function to either import or exclude Character definitions with your
FBX file. See FBIK definition on page 81 for more information.

FBXImportConstraints
FBXImportConstraints -v [true|false]

FBXImportConstraints -q

Causes all constraints defined in the FBX file to be ignored by the importing
process and excluded from the Maya scene. See Constraints on page 81 for
more information.
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FBXImportConvertDeformingNullsToJoint
FBXImportConvertDeformingNullsToJoint -v [true|false]

FBXImportConvertDeformingNullsToJoint -q

Converts deforming elements into Maya joints.

True

Transforms all deforming elements into joint nodes.

NOTE This option was originally provided because Maya did not support locator
elements (that is, transform nodes that are not joints,) within a bone hierarchy.
While Maya now supports this, in some cases this option improves the skinning
behavior.

See Deforming elements to joints on page 79 for more information.

FBXImportDxfWeldVertice
FBXImportDxfWeldVertice [true|false]

FBXImportDxfWeldVertice -q

NOTE This command is for the Macintosh and Linux platforms only.

FBXImportDxfReferenceNode
FBXImportDxfReferenceNode [true|false]

FBXImportDxfReferenceNode -q

NOTE This command is for the Macintosh and Linux platforms only.

FBXImportDxfObjectDerivation
FBXImportDxfObjectDerivation [layer|entity|block]

FBXImportDxfObjectDerivation -q

NOTE This command is for the Macintosh and Linux platforms only.
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FBXImportFillTimeline
FBXImportFillTimeline -v [true|false]

FBXImportFillTimeline -q

Fills the scene timeline on import (instead of using the Maya default).

FBXImportGenerateLog
FBXImportGenerateLog -v [true|false]

FBXImportGenerateLog -q

Use this command to generate a log file on export. See Generate log data on
page 88 for more information.

FBXImportHardEdges
FBXImportHardEdges -v [true|false]

FBXImportHardEdges -q

Merges back all vertices located at the same exact position as a unique vertex.
The Maya FBX Plug-in then determines if the edges connected to each vertex
are hard edges or smooth edges, based on their normals.

Use this function when FBXExportHardEdges is set to True on export.

This command is the script version of the Combine per-vertex Normals option
in the FBX Importer. See Combine per-vertex Normals on page 76 for more
information.

FBXImportLights
FBXImportLights -v [true|false]

FBXImportLights -q

Use this function to either include or exclude lights from the import process.
See Lights on page 82 for more information.
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FBXImportMergeBackNullPivots
FBXImportMergeBackNullPivots -v [true|false]

FBXImportMergeBackNullPivots -q

True

Assigns the rotation transformation of the null (or joints) elements in the
hierarchy that are used as pre-rotation and post- rotation to the joint orient
and the rotate axis of the original node.

The pre-rotation and post-rotation nodes are then deleted.

The look-up is done by name as the pre-rotation node's name contains the
“__Pre_ “suffix, while the post-rotation node's name has a “__Post_” suffix.

NOTE

When the import mode is set to Exmerge or Merge this option is automatically
set to True.

FBXImportMergeAnimationLayers
FBXImportMergeAnimationLayers -v [true|false]

FBXImportMergeAnimationLayers -q

Activate Bake animation layers to bake (or Plot) animation layers contained
in the incoming file.

FBXImportMode
FBXImportMode -v [exmerge|add|merge]

FBXImportMode -q

This command has three possible states:

Exmerge

Merges the imported FBX file to the current scene in the following way:

Nodes of the same name and nature have only their animation curve replaced.
No new nodes are created.
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Add

Creates a new scene prior to the file import.

Merge

Merges the imported FBX file to the current scene in the following way: any
node without its equivalent in the scene is created. Nodes with the same name
but not of the same nature, for example, sphere and bone, are replaced. Nodes
with the same name and nature only have their animation replaced.

FBXImportProtectDrivenKeys
FBXImportProtectDrivenKeys -v [true|false]

FBXImportProtectDrivenKeys -q

Use this script to prevent any incoming animation from overwriting channels
with driven keys.

If set to True, the driven keys are protected and no incoming animation is
applied to the driven channels.

If set to False, the driven keys are discarded and the incoming animation is
applied to the driven channels. See Protect driven keys on page 79 for more
information.

FBXImportQuaternion
FBXImportQuaternion -v [quaternion|euler|resample]

FBXImportQuaternion -q

Lets you specify how quaternion rotations should be treated on import into
Maya. This option compensates for differences between Maya and
MotionBuilder quaternions. See Quaternion interpolation mode on page 78
for more information.

FBXImportResamplingRateSource
FBXImportResamplingRateSource -v [Maya|FBX|Custom]

FBXImportResamplingRateSource -q
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This command lets you set the rate that the FBX Exporter uses to produce
keyframes when it needs to resample data.

Resampling is used when the interpolation of the Maya animation curve
cannot be accurately represented by curves in MotionBuilder.

FBXImportScaleFactorEnable
FBXImportScaleFactorEnable [true|false]

FBXImportScaleFactorEnable -q

This command is the script version of the Scale Factor option of the FBX
Importer. See Scale Factor on page 83 for more information.

FBXImportScaleFactor
FBXImportScaleFactor [float]

FBXImportScaleFactor -q

This command is the script version of the Scale Factor menu in the FBX
Importer. See Scale Factor on page 83 for more information.

FBXImportSetMayaFrameRate
FBXImportSetMayaFrameRate -v [true|false]

FBXImportSetMayaFrameRate -q

This command lets you import the frame rate from the FBX file. This overwrites
the rate used in Maya.

FBXImportSetLockedAttribute
FBXImportSetLockedAttribute -v [true|false]

FBXImportSetLockedAttribute -q

This command is the scripting equivalent of the UI dialog box Keep all locked
or unlock all options. Use this command when you import an FBX file that
contains animation onto an object that has locked channels.
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When you use the UI, the Maya FBX Plug-in prompts you to either keep all
the channels locked or unlock the locked channels, which imports the
animation correctly. This had created problems for users who tried to do this
without working in the UI.

False

Unlocks all channels.

True

Channels remain locked.

Example code

FBXImportSetLockedAttribute -v False;FBXImport -f "C:/myFile.fbx";

FBXImportShapes
FBXImportShapes -v [true|false]

FBXImportShapes -q

Use this script to import or exclude shapes from your FBX file. See Deformed
Models on page 80 for more information.

FBXImportSkins
FBXImportSkins -v [true|false]

FBXImportSkins -q

Use this function to import or exclude skin deformations from your FBX file.
See Deformed Models on page 80 for more information.

FBXImportUnlockNormals
FBXImportUnlockNormals -v true|false

FBXImportUnlockNormals -q

Overrides the default Maya locking of normals.
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True

Recomputes the normals on the objects using Maya internal algorithms.

FBXImportUpAxis
FBXImportUpAxis [y|z]

FBXImportUpAxis -q

This command is the script version of the Axis conversion option in the FBX
Importer. See Axis conversion on page 88.

FBXConvertUnitString
FBXConvertUnitString [mm|dm|cm|m|km|In|ft|yd|mi]

This command returns the Scale Factor required to convert one centimeter to
the specified unit and is the script version of the File Units Converted To
menu in the FBX Exporter and Importer windows. See File Units converted
to on page 84 for more information.

FBXGetTakeComment
FBXGetTakeComment [index]

Returns the comment attached to the take at the specified index in the take
array. This command uses the file stored in the file buffer.

You can load a file into the file buffer with the FBXRead command.

NOTE You must enter numbers from 1 to the number of takes contained in the
file otherwise the script returns the message: No such take. The Maya FBX Plug-in
considers any number of takes greater than the amount of takes in the file, negative
values, or zero, to be invalid.

FBXGetTakeCount
FBXGetTakeCount

Returns the number of takes saved in the file stored in the file buffer.

You can load a file into the file buffer with the FBXRead command.
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NOTE If Maya FBX Plug-in does not find any takes in the file, the script returns a
value of 0.

FBXGetTakeIndex
FBXGetTakeIndex [take name]

Returns the index of the first take named as the parameter in the take array.
This command uses the file stored in the file buffer.

You can load a file into the file buffer with the FBXRead command.

NOTE If [take name] does not contain a valid name, the script returns the message:
No such take.

FBXGetTakeLocalTimeSpan
FBXGetTakeLocalTimeSpan [index]

Returns the local start and stop time of the take at the specified index in the
take array. This command uses the file stored in the file buffer.

You can load a file into the file buffer with the FBXRead command.

NOTE You must enter numbers from 1 to the number of takes contained in the
file, otherwise the script returns the message: No such take. The Maya FBX Plug-in
considers any number of takes greater than the amount of takes in the file, negative
values, or zero, to be invalid.

FBXGetTakeName
FBXGetTakeName [index]

Returns the name of the take in the take array's specified index. This command
uses the file stored in the file buffer.

You can load a file into the file buffer with the FBXRead command.

NOTE You must enter numbers from 1 to the number of takes contained in the
file otherwise the script returns the message: No such take. The Maya FBX Plug-in
considers any number of takes greater than the amount of takes in the file, negative
values, or zero, to be invalid.
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FBXGetTakeReferenceTimeSpan
FBXGetTakeReferenceTimeSpan [index]

Returns the reference start and stop times of the take at the specified index
in the take array. This command uses the file stored in the file buffer.

You can load a file into the file buffer with the FBXRead command.

NOTE You must enter numbers from 1 to the number of takes contained in the
file, otherwise the script returns the message: No such take. The Maya FBX Plug-in
considers any number of takes greater than the amount of takes in the file, negative
values, or zero, to be invalid.

FBXLoadExportPresetFile
FBXLoadExportPresetFile -f [filepath]

Sets the export preset file path.

FBXLoadImportPresetFile
FBXLoadImportPresetFile -f [filepath]

This command lets you set the import preset file path.

FBXRead
FBXRead -f [filename]

Reads the specified FBX file without importing anything into Maya. The file
is instead stored in a buffer. This command is used for take querying.

Once read or imported, use the commands FBXGetTakeCount,
FBXGetTakeName, FBXGetTakeIndex for take querying.

NOTE The file you are reading must match an existing file name, otherwise the
file in the buffer is destroyed if you attempt to read or import a non-existent file.

FBXResetImport
FBXResetImport
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This command restores the default values of the FBX Importer.

FBXResetExport
FBXResetExport

This command restores the default values of the FBX Exporter.

FBXResamplingRate
FBXResamplingRate -v [float]

FBXResamplingRate -q

Sets the rate at which the exporter produces keyframes when it needs to
resample data.

Resampling is needed when the interpolation of the Maya animation curve
cannot be perfectly represented by curves in MotionBuilder.
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Troubleshooting and
Limitations

Because the Maya FBX Plug-in supports so many software packages, it is inevitable that
occasional problems will occur or some details will not yet have attained perfect support.

Occasionally, the default settings of plug-in do not respect a particular workflow, or the
conversion process creates conflicts between two packages with similar but not identical
functions. Sometimes a file is exported correctly but becomes inexplicably larger, or the assets
in the file are no longer in the same location as they were before conversion.

This section contains a troubleshooting guide for problems with the import or export process
as well as contains details on known limitations for the Maya FBX Plug-in.

Troubleshooting
This section contains descriptions of some advanced problems, explains why
they occur, and if available, offers workarounds.

If none of the topics in the Troubleshooting or Limitations section help you,
search the  FBX Forums. The forums contain ongoing discussion about the Maya
FBX Plug-in, as well as an e-mail address where you can contact support.

■ Where did the FBX UI go? on page 120

■ Where are my textures? on page 120

■ Where are my MotionBuilder layers? on page 121

■ Why are my cameras inconsistent? on page 122

■ Why are my normals locked on import? on page 122

■ Why does the plug-in not match the help documentation? on page 123
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■ The plug-in does not run on page 123

■ Why do my MotionBuilder edges look different? on page 123

■ Why are my sets empty? on page 124

Where did the FBX UI go?
If you import or export FBX files and the FBX Importer or Exporter window
does not appear, it could be because the Maya FBX Plug-in cannot find MEL
scripts that are included by the FBX installer. The scripts are automatically
installed to the following path:

<Maya version>/scripts/FBX

If they are deleted, the FBX user interface no longer appears. You can restore
these files which will bring back the interface if you reinstall the plug-in.

Maya Default UI

If you are using the Maya Default UI setting, the FBX options to the right of
the file browser area may be collapsed. Drag the splitter bar at the right side
to the center of the dialog box to expand the FBX options.

Where are my textures?
Textures disappear from files when if you move or delete any texture from
the relative and absolute paths of the associated media files location. This can
happen when you give the FBX file to someone using a different computer
who does not have that texture in that your directory on the your computer
drive.

Use the Embed Media option to make the FBX plug-in includes (embeds) the
associated media (textures, for example) within the FBX file. The plug-in then
extracts the media to an .fbm folder at import. The plug-in copies the
embedded media to a <fileName>.fbm folder in the same location as the FBX
file and is named after the FBX file.

NOTE When you activate Embed Media, the media is contained within the FBX
file itself, and this has an impact on file size. It is good practice to use this option
only when you transport an FBX file to a location where the original media source
is no longer accessible by the receiver.
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If you disable the Embed Media option, the FBX plug-in stores the relative
and absolute paths of the associated media files at export time. This causes
problems if, for some reason, the path is no longer accessible. Make sure that
the associated media is accessible to ensure the proper import of these media
files.

Why should I embed media?

If you export a file to FBX and do not activate the Embed Media option, no
problems occur if you open the file on the same computer and all the images
used in the scene are in the same locations that they were when the file was
exported.

It is a good practice to embed media when you are going to give the FBX file
to another person. It is also a good practice to embed when you use FBX for
storing assets, as you may eventually delete the reference images or move all
the files to another drive or computer with different paths.

NOTE If you export your file in ASCII format in FBX versions 2010 and earlier, no
textures are embedded.

Embed Media is active, but I still do not see my textures

In previous versions of the Maya FBX Plug-in, when you saved an FBX file
with the Embed Media option activated, the embedded files were extracted
to a folder in the same location as the FBX file. If you did not have write
permission for the folder, then the media files were not extracted. You can
experience this lack of write permission when you work over a network.

With the current version of the Maya FBX Plug-in, if you do not have write
permission for the folder creation, the media files are sent to a temp folder
instead.

NOTE If you export your file in ASCII format using FBX versions 2010 and earlier,
no textures can be embedded.

Where are my MotionBuilder layers?
The Maya FBX Plug-in lets you import animation layers without baking them.
Otherwise, the animation is baked into the base animation layer.
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To retain animation layers as separate layers in Maya:

When you import an FBX file, disable the Bake Animation Layers option in
the Maya FBX importer. See Bake animation layers on page 77

If the option is active, the plug-in automatically bakes the animation layers
during the import process.

Why are my cameras inconsistent?
If you import a Maya camera into 3ds Max using a Fit Resolution Gate setting
of Vertical or Fill, the results will differ.

For better support between Maya cameras in 3ds Max, set the Fit Resolution
Gate setting to Horizontal, rather than Vertical or the default, Fill.

NOTE You can import 3ds Max cameras into Maya with no difficulty; Maya renders
the same result.

Why are my normals locked on import?
If you import non-deformed geometry, the normals are locked on import to
Maya. These locked normals can create problems when you deform the
geometry in Maya.

For example, if you import blend shape targets that were created in 3ds Max
and then export them to FBX, they import into Maya with their normals
locked.

You can address this problem if you unlock the deformed object's normals in
Maya. To unlock the normals, import the geometry into Maya and then select
Normals > Unlock normals.

What causes this?

If you import non-deformed geometry the normals are locked when you
import it to Maya.

When normals are locked by Maya, they will not move with the geometry
when you deform the imported objects. If you do not unlock these normals,
you may experience shading issues when you apply modifiers such as skin or
blendshapes.
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Why does the plug-in not match the help
documentation?

If you find something in your version of the Maya FBX Plug-in that does not
appear in the documentation, consult the readme file that accompanied the
plug-in. The readme will contain last-minute changes to the software that are
not reflected in the documentation.

It is also possible that your version of the Maya FBX Plug-in may not be the
most recent version. It is a good practice to check for updates, as each
subsequent Maya FBX Plug-in version has enhanced functionality, and is
available free. See Web updates on page 35 for instructions on how to verify
that your plug-in version is the latest.

NOTE You can also use the comment link at the bottom of the online help to
send a comment to the FBX team.

The plug-in does not run
Plug-ins run only on the version of Maya for which they are created; verify
that the version of the Maya FBX Plug-in that you are installing is appropriate
for the version of Maya you are running.

Why do my MotionBuilder edges look different?
Older versions of MotionBuilder (versions 2010 and earlier) do not support
hard/soft edge normals and can result in shading issues in MotionBuilder.

If you are using an earlier version of MotionBuilder and this problem occurs,
activate the Split per-vertex normals option. When you activate this option,
geometry vertex normals are split based on edge continuity. Vertex normals
determine the visual smoothing between polygon faces. They reflect how
Maya renders the polygons in smooth shaded mode.

Why would I use this?

This option lets you keep the same hard/soft edge look that you get from Maya
in MotionBuilder.

Do not use this option if you do not require hard edges in MotionBuilder,
since this operation duplicates vertex information and converts the geometry
itself. You can use the Combine per-vertex Normals option in the FBX Importer
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to perform the inverse operation, but this may result in incorrect UV texture
maps, see the note that follows this entry.

If you are not using a merge-back workflow (merging FBX into existing scene)
using this option may result in incorrect UV mapping when reimporting the
FBX file into Maya. Import your FBX file into to your original Maya scene, to
avoid geometry UV issues with split geometry.

Exporting with the Split per-vertex Normals option disabled produces the
following result in MotionBuilder:

Exporting with the Split per-vertex Normals option activated produces the
following result in MotionBuilder:

NOTE Using this option alters UV maps applied to geometry permanently. The
UVs are then properly reassigned to the newly split geometry. When you import
this geometry into an empty Maya scene, there is a UV limitation where using
Combine per-vertex Normals in the FBX Importer might result in incorrect UV
assignments.

Why are my sets empty?
This is due to a limitation. See Selection sets on page 127 for more information.
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Limitations
The following section contains a list of known limitations for this version of
the Maya FBX Plug-in. If you have problems with the plug-in that are not
listed here, refer to the Troubleshooting on page 119 section.

■ Preset Bake Animation settings on page 125

■ Non-orthogonal matrices on page 125

■ Cannot cancel file overwrite on page 126

■ Cluster import on page 126

■ Scale compensation on page 126

■ Selection sets on page 127

■ Instanced geometry on page 127

Preset Bake Animation settings
You cannot save Bake Animation settings (Start/End/Step values) in Preset
files. If you created a preset that had specific settings for the Bake Animations
values, these values will not be used the next time you load the preset. Instead,
the FBX plug-in will always default to the values set for the scene's timeline.

For example, if the animation in the scene is 102 frames long, the Start value
will be 1, the End value will be 102, and the Step value will be 1, regardless
of what is values you may have stored in the preset for this setting.

Non-orthogonal matrices
“Orthogonal” is a term used to describe two vectors that are perpendicular (at
90 degrees) to each other. In 3D space, when the X, Y, or Z-axes are not
perpendicular, they are considered “non-orthogonal” and the FBX plug-in
does not support their representation as a matrix. For example, a
non-orthogonal set of axes can occur when you use rotation and scaling to
skew an object.

Because the FBX plug-in assumes that there is always a 90 degree angle between
the X, Y, and Z axes, it can support only orthogonal matrices. Any transformed
axes that have non-orthogonal TRS matrices are ignored by the FBX plug-in,
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so it does not import or export effects created when axes are not orthographic.
Because of this, any non-orthogonal effect (such as skewing) is lost.

This can cause problems even when you have transformation data that has
been inherited from other objects, for example, scaling via a parent object
where the result is a non-orthogonal local TRS matrix.

Cannot cancel file overwrite
In previous versions of the Maya UI (before version 2011), as well as the
"Classic" OS Native UI that is still available in Maya 2011, if you want to
overwrite an existing file, the Overwrite dialog box appears. If you select Yes,
and then cancel the export in the FBX exporter window that appears, the FBX
file that was to be overwritten is instead deleted.

This is not a problem if you use the Maya 2011 default UI while exporting to
FBX because the file browser and exporter options now appear in the same
window. If you use the Maya Default UI to export to FBX, you can cancel the
export operation without deleting the original FBX file. See Switching the FBX
UI on page 25.

Cluster import
To import clusters correctly into Maya, deactivate the Deforming elements to
joints on page 79 option. Otherwise their cluster pivots do not import correctly.

Scale compensation
There is no limitation for the scale compensate setting in the Maya FBX Plug-in
itself.

However, there is a limitation in 3ds Max. If you modify the scale of joints
that are parents of other joints in Maya, a conversion is performed that
compensates for the scaling behavior that is not found in 3ds Max. This is
done by animating the scale of the child joint. This conversion maintains the
visual fidelity of Maya animation in 3ds Max.

What does Scale Compensate do?

If you scale a parent joint in Maya using scale compensation, it creates an
offset for a child joint rather than scaling it.

But if you do the same thing in 3ds Max, the child scales and creates no offsets.
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Selection sets
A known limitation exists where sets that contain NURBS Sub-components,
such as Isoparm, Control Vertex, or Surface Patch, are not retained in sets and
will not be exported.

Instanced geometry
A limitation exists where FBX does not support instanced geometries that
have materials that differ from the original geometry object.
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Maya FBX Plug-in glossary

.fbm file The file generated when you export an FBX file with the Embed Media option
activated. The FBM file contains all the associated textures in the FBX file. The “M” in FBM
is for “Materials”. See Embed media on page 56.

.mc file Autodesk point cache file extension.

.pc2 file Legacy 3ds Max point cache file extension.

.xml file Extensible Markup language file. The Maya FBX Plug-in creates an XML file when
it processes point cache data.

ASCII Stands for American Standard Code for Information Interchange.

bake Baking is a re-sampling of all the animation data within your scenes.

Bind pose (Maya) In animation, the default position of a skeleton, used to keep track of
transformation attributes for all the skeleton’s joints and influence objects.

bone Bones are 3D objects that you can link like human joints to create animation.

curve See FCurve on page 130.

Degrees of Freedom (DOF) Degrees of Freedom (DOF) are MotionBuilder properties that let
you limit translation, rotation, and scaling of objects or animated hierarchies. Defining Degrees
of Freedom for objects in a scene lets you restrict their range of movement.

destination application The application in which you want to use your FBX file.

dummy A type of 3ds Max helper object, a placeholder.

edge An edge is a straight or curved line that connects two vertices in a mesh object or spline.
You can modify object shapes by transforming its edges.

Euler In animation, a method of rotation that uses three angle values (X, Y and Z) plus a
rotation order to specify three-dimensional orientation. Euler rotation has several drawbacks,
including Gimbal lock on page 130 and choppy interpolation between keyframes.
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FBX file An Autodesk FBX format file used as a universal 3D Asset Exchange.

FCurve (MotionBuilder) (Also referred to as a Function Curve.) A graphic depiction of an
animated value. The time and value of the animated value displays on two axes: the vertical
axis representing the value, and the horizontal axis representing the time.

fps Frames per second.

geometry (Maya) In general, a surface, NURBS on page 130, NURBS curve, subdivision surface,
or polygonal surface (mesh). (3ds Max) Geometry refers to all objects that are not cameras
or lights. Meshes, polys, patches, NURBS, splines, helper objects, etc.

Geometry cache A file that stores positions of vertices. Cache files let you preview the
results of a simulation without rendering the scene.

Gimbal lock A Gimbal Lock occurs when you rotate one axis and accidentally align the
two other axes. When these two axes align, you lose one axis because you cannot separate
them. When a gimbal lock occurs, your bone can rotate only in two axes instead of all three.

host application The application used to create the file you are going to save as an FBX
file.

key A reference point, or key point, that marks the position of an important action or
change in a scene at a specific point in time.

mesh In polygonal modeling, a collection of polygons, which can be of different types
(triangles, quads, n-sided).

morph Morphs (or per-vertex) is a method of 3D computer animation that is sometimes
used as an alternative to skeletal animation. Morph target animation is stored as a series of
vertex positions. In each keyframe of the animation, the vertices are moved to a different
position.

Depending on the renderer, vertices move along paths to fill the empty time between
keyframes. The renderer can also switch between different positions.

Animation composed in one 3D application suite may require transfer to another, such as
for rendering. To avoid export issues, native animation formats often convert to morph
target animation. This is necessary to accomodate the implementation of bones and other
special effects in different 3D application suites

normal In modeling, the directional line perpendicular to a surface. Polygon normals
indicate the orientation of polygonal faces. Because shaded (or rendered) faces are visible
only when the normals are facing towards the viewer, it is sometimes necessary to reverse
a normal to correct a face’s orientation.

NURBS Non-Uniform Rational B-Spline. A type of geometry that includes curves, patches,
surfaces, etc. NURBS are a superset of conics, splines, and Bezier curves. They are particularly
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suited for modeling in 3D, because they provide excellent continuity with a minimum
number of control points.

NURMS Non-Uniform Rational MeshSmooth. A NURMS object is similar to a NURBS object
in that you can set different weights for each control vertex.

Orthogonal Describes vectors that are perpendicular (at 90 degrees) to each other. In 3D
space, when the X, Y, or Z-axes are not perpendicular, they are considered "non-orthogonal".
The Maya FBX Plug-in has a limitation related to non-orthogonal axes. See Non-orthogonal
matrices on page 125.

Point cache (3ds Max) A file (or series of files) that stores positions of vertices. Cache files
let you preview the results of a simulation without rendering the scene.

polygons An n-sided shape defined by a group of ordered vertices and the edges that are
defined between pairs of those vertices. Polygons can be either simple shapes, such as
polygonal primitives, or complex models built from the various polygonal tools. A polygonal
object can be closed, open, or made up of shells, which are disjointed pieces of geometry.
Also known as mesh.

procedural image map An image not composed of a fixed matrix of colors, but rather
generated procedurally by a mathematical algorithm. You cannot transfer these textures
through the FBX format.

Quaternion interpolation A method of rotation that uses a unit quaternion (a quaternion
of length one) to represent an orientation in three dimensions. A quaternion is a four
dimensional extension to complex numbers. Quaternion rotation is an option that is useful
for avoiding Gimbal lock on page 130.

resample The process of creating a key for every nth frame of an animation's interpolation
(or curve).

selection set (3ds Max) A group of objects that have a name assigned to them.

skin A deformation tool that lets one object deform another, for example a skeleton deforms
a mesh.

smoothing groups Smoothing groups define whether a surface is rendered with sharp edges
or smooth surfaces.

Smoothing groups are numbers assigned to the faces or patches of an object. Each face or
patch can carry a maximum of 32 smoothing groups. If two faces or patches share an edge
and share the same smoothing group, they render as a smooth surface. If they do not share
the same smoothing group, the edge between them renders as a corner.

take (MotionBuilder) An animation scene done between one start and the following stop,
a segment.
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triangles Objects in 3D scenes are composed of triangles. The triangles are defined as three
XYZ vertex coordinates.

UI User interface.

up-axis The up axis is the global axis that is pointing upwards.

(Maya) There are two choices of axis (Y or Z) as the world up direction. The Y axis is used
as the default up axis.

(3ds Max) The Z axis is used as the world up axis. This cannot be changed.

Y-axis Maya’s default up-axis.

Z-axis 3ds Max’s default up-axis.
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